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Instrument Information

Oncore Pro X Automated Slide Staining System: ONCPRX00001
Software Version: 4.0

Computer Configuration:

Laptop or Desktop Computer with Mouse
Instrument Communications Interface: USB 2.0
USB Cable must be <3 meters (10 feet)

The use of this instrument is fully licensed under U.S. Patent no. 5,839,091; U.S. Patent no. 7,476,543; U.S.
Patent no. 7,635,453; and U.S. Patent no. 7,977,086 B2.

Software Product License

IMPORTANT: Please read the license carefully before using this Software. The right to use this Software is granted
only if the Customer agrees to the terms of this license

HOWEVER, USE OF THIS SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.

In return for the payment of the applicable one time license fee included with the purchase price of the
instrument, BioCare grants the user a license to use one copy of the Software subject to the following terms and
conditions. No title or ownership of the Software is conferred with this license.

The Software may be used on one Oncore Pro X Automated Slide Staining System.

The Software may not be copied.

The Software may not be disassembled, decompiled, decrypted or reverse engineered.

BioCare reserves the right to terminate this license upon breach. In the event of termination at BioCare’s
election, all copies of the Software must be returned to BioCare.

5. No title or ownership of the Software is conferred with this license.

el N
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Safety

Report any serious incidents related to this device to your local Oncore Pro X representative and the state's
competent authority. Contact your local representative if you have any questions or concerns regarding safety.

Protection from High Temperatures &

The instrument is equipped with a safety interlock system so that the door remains locked during instrument
operation. However, the heaters inside may reach high temperatures. Care must be exercised to make sure that
the heaters have cooled down sufficiently before removing the slides.

Protection from Moving Parts

The instrument is equipped with a safety interlock system so that the door remains locked during instrument
operation. The interlock will automatically engage to restrict access to the inside of the instrument while it is the
instrument is in operation. Never tamper with the safety interlock system.

Use of Hazardous Reagents

Some reagents used on the instrument may be considered hazardous. Hazardous reagent wastes must be
disposed of according to local, state and federal regulations. Wear appropriate Personal Protective Equipment to
prevent exposure. It is the responsibility of the user to comply with the local, state and federal regulations.

Maintenance

Do not attempt to service the instrument unless instructed to do so by Technical Support. Doing so will void the
warranty. Removing the back panel may also electrical hazard.

The instrument must be unplugged from the power source before the outer housing can be removed. The power
supply is connected to 120/240V power source and the power cord must be disconnected from the AC power port
before any maintenance work is started.

Decontamination
Use bleach at 1:10 dilution to decontaminate the instrument. Do not use bleach with any other chemicals because
it may react and create toxic fumes. Decontaminate in a well ventilated room.

ONCORE Pro X, Operating Manual, Rev. L 6



Section 1. Introduction

Intended Use of the Equipment

The Oncore Pro X Automated Slide Staining System is a fully-automatedfully automated slide processing system for
staining paraffin-embedded and frozen tissue sections, cytospins, cell smears and fine needle aspirates. This
universal system is designed to automate the manual staining methods routinely used in immunohistochemistry, in
situ hybridization and related applications. The intended use of the instrument is RUO (Research Use Only).

Quick Start-up

The Oncore Pro X Service Team installs and tests each system to ensure optimal performance.

The system is factory-installed with a set of standard protocols optimized for use with the Oncore Pro X detection
kits and its comprehensive line of ready-to-use primary antibodies and probes.

Flexible Programming

The Oncore Pro X Automated Slide Staining System software implements user-customized protocols and slide-
specific programming. The system provides intuitive programming routines, reagent and slide loading maps and a
convenient run time display. Each staining run can process 1 to 36 microscope slides. Each slide can be
programmed to run a different protocol.

Economic Use

The Oncore Pro X Automated Slide Staining System maximizes efficiency by operating with small volumes of
reagent and wash buffer, effectively reducing supply and waste disposal costs. The system provides the flexibility
to optimize reagent volumes and wash steps.

Reagent RFID Tags

Reagent RFID tags store programmable information such as reagent name, lot number and expiration date. The
on-board RFID reader scans and identifies reagent vials to automatically determine if there are sufficient resources
to complete a selected staining protocol.

Slide 2D Barcode Labels

The Oncore Pro X Automated Slide Staining System software provides a simple user interface to generate and print
2D Barcode labels for slides. The on-board 2D barcode reader scans and identifies slides to automatically program
a run and track slides. All printed labels are heat and chemical-resistant, allowing users to apply slide labels prior to
starting the staining procedure.

ONCORE Pro X, Operating Manual, Rev. L 7



Section 2. System Specifications

The Oncore Pro X Automated Slide Staining System employs a unique integration of hardware, software, and
reagent chemistry to provide full automation of immunohistochemical staining methods. This section provides an
overview of the instrument and details the technical specifications.

2.1. Instrument Overview

1

Figure 1

Slide Deck holds 36 modules, a reagent rack, and 2 probe wash stations.

X axis mechanism moves the robotic arm from left to right.

Y axis mechanism carries the Z head assembly and moves the arm from front to back

Z head Assembly consists of 2 independent Z axes (Z1 and Z2) situated on the Y arm.

Power Button turns the instrument on/off.

Door controls access to the instrument.

Linear Solenoid locks the door.

Safety Interlock Switch blocks unsafe access to the instrument while the robotic arm is in motion.
Liquid Level Sensor (Z1 only) detects the liquid level in the reagent vial and waste station during runtime.
The system will issue a warning when a reagent vial has insufficient volume or when a waste station is
overflowing.

LONURWNRE

ONCORE Pro X, Operating Manual, Rev. L 8



N

ouRw

8.

9.

10

2D Barcode Reader scans the labelled slides on the slide deck to assign protocols for the staining run.
RFID Reader scans the RFID-tagged reagent vials to determine the reagents’ positions on the rack and
updates the reagent usage information to the RFID tags during the run.

Reagent Rack holds the reagent vials. There are 40 available reagent vials positions.

Reagent Vials holds the reagents. 15mL and 7mL size options.

Pumps (Z1 and Z2) draw and dispense buffer and reagents through the in-line tubing (max 5mL capacity)
Wash/Waste Station is an assembly located in the rear left corner of the instrument and is used as a
cleaning station for the reagent probes. There is a purging position for the reagent waste and a
percolating position for cleaning the outside of the probe each time a new reagent is used.

Hazardous Wash/Waste Station is a second probe wash station dedicated to hazardous reagents.
Hazardous reagents will be separately dispensed into the hazardous waste station and will be collected in
the Hazardous Waste Container.

Z1 Probe is a Teflon™-coated stainless steel probe that aspirates the reagents from the vials/in-line wash
buffer and dispenses the reagents into the chambers.

Z2 probe is a Teflon™-coated stainless steel probe that extracts the reagent waste from the chambers and
aspirates/dispenses reagent during on-board mixing.

10. Module is an assembly that holds 1 glass slide. 36 modules per instrument.

Not pictured:
11. Tubing (Z1 and Z2) connects the pumps with the probes to transfer buffer, reagents, and waste.

ONCORE Pro X, Operating Manual, Rev. L 9
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Figure 3
1. Feet adjusted to level the instrument on the work surface.
2. Main Power Supply connects to the wall outlet and provides power to the instrument.
3. Power Supply Switch turns the power supply on/off.
4. ACPower Port is the position to plug in the power cord.
5. Fan provides cooling to the instrument and its electrical components.
6. USB Port is the position to plug in the USB cable.
7. U-Ring is the position to attach an anti-theft chain to the computer.
8. Waste Tubing (Blue) connects the waste station to the waste container to transfer waste (gravity-fed).
9. Hazardous Waste Tubing (Black) connects the waste station to the hazardous waste container to transfer

hazardous waste (gravity-fed).
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Figure 4

ONCORE Pro X, Operating Manual, Rev. L

1. Side Retainer Clips (2) secure the module onto the
instrument deck plate.

2. LED Light displays heater status green (inactive) or
orange (active).

3. Hinge secures the slide at the back.

4. Chamber Chimney reagent dispensation/waste
extraction point.

5. Slip Holder holds the chamber. Moves to controlled
angles to facilitate incubation and reagent
dispensation/waste extraction.

6. Chamber (consumable) holds reagent/buffer on the
slide during the incubation and washes.

7. Side Rails (2) secure the slide on the left/right.

8. Heater maintains temperature during incubation.

9. Slide Clip secures the slide at the front.

Not pictured:

10. Glass Slide is a standard microscope slide to which
specimen(s) are mounted for processing on the
instrument. Standard slide dimensions are 25mm x
75mm x Imm.

11



2.3. Technical Specifications

Dimensions W x Hx D
36.5in x 22in x 24in/93cm x 56cm x 61cm
(with door closed)

36.5in x 36in x 24in/93cm x 91cm x 61cm
(with door open)

Electrical requirements

120V 110/120V (+10%) 60Hz (+2Hz) 850 watts
220V 220/240V (+10%) 50Hz (+2Hz) 850 watts
Mains Connection: IEC320

Slide capacity
1-36 glass slides

Heating capacity

Room temperature to 103°C. Maximum 110°C.

Reagent dispense volumes
130uL standard test volume
(65 minimum-400 ul maximum)

Recommended Computer Controller Specifications

Weight
125lb (57kg)

Normal operating temperature
18°C-26°C (64°F-79°F)

Reagent capacity
40 different reagents (15 mL/7mL reagent vial)

Waste Separation
1 hazardous waste, 1 non-hazardous waste

Reagent probe volume capacity
20 pL minimum-4500puL maximum

The manufacturer reserves the right to change the computer controller specifications at any time.

Intel Core i5-2410M CPU 2.3GHz, or equivalent

8GB RAM
500GB Hard drive or 256GB SSD drive
4 USB 2.0 communication ports, or equivalent

Display Specifications

16:9 aspect ratio, minimum resolution 1366 x 768

Label Printer (ZPL)
Zebra GX430t, Zebra ZD620t, or Zebra ZD621t

Surge Protector
120/240 VAC, 15 Amps, 50/60 Hz

LIS Connectivity

Compatible with SQL Database and HL7 messaging standards.

Operating Logic

Operating System
Windows 10 Pro (64 bit), English (US Region)

Designed to calculate the most time-efficient sequence of steps to complete a programmed staining run.

Protocol Logic

Protocols are generated from a common protocol template optimized for each detection system.
End-users have the limited ability to customize key protocol steps.
Advanced users have full flexibility to add/remove and customize each step in the protocol template and to

generate special protocols.

ONCORE Pro X, Operating Manual, Rev. L
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2.4. Accessories Included with the Instrument

Reagent Rack Two removable reagent racks. Each reagent rack holds a maximum of 40 reagent vials.
Removable Vial Holder Installed on the reagent rack for programming RFID-tagged reagent vials.
Buffer Container 2L plastic bottle with quick disconnect fittings. Stores the in-line wash buffer.
Waste Container Set of two 4L plastic bottles with cap. Stores the reagent waste generated during the run.
Label Printer 2D barcode printer, thermal transfer.

Labels Size 19.05mm (0.75in) x 25.4mm (1in), 1000 labels/roll.

Ribbon Media ribbon for the printer.
USB Cable Connects the instrument and computer.
Power Cord, Instrument
Computer Pre-configured for use with instrument.
Computer Mouse
Lint-free Alcohol Wipes

Chamber Set of 36 pre-installed on the modules.

ONCORE Pro X, Operating Manual, Rev. L 13



2.5. Slide Specifications
To ensure staining quality and reliability, slides should be prepared following the instrument’s guidelines.

Slide Dimensions
Standard slide dimensions are 25mm x 75mm x 1mm

Material Glass, 1SO 8037/1

Dimensions (mm)
Width 25-26.0 mm (0.98-1.02 in)
Length 74.75-75.5 mm (2.94-2.97 in)
Thickness 0.95-1.1 mm (0.038-0.043 in)

A Note: Use of non-standard slides may affect staining area and staining quality.

Tissue Thickness
The recommended tissue thickness is 2-5 microns.

Tissue Placement

The circled area is the recommended tissue placement area.

The yellow highlighted region is the staining area range. This range may be expanded to the blue highlighted
regions; however, staining results may not be ideal in these areas.

A Emm n

| ] =l " =} P—

sl s 30mm
40mm ﬁ? % 'IT ?l'
L] f& | Wl f

,‘
—
o

Smm

| IHC ISH/FISH

20mm

)

The IHC staining area extends to the 40 mm line on the slide.
The ISH staining area extends to the 30 mm line on the slide.

Figure 5
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Section 3. Installation Requirements and Instructions

This section provides an overview of the instrument installation to be performed by the field service engineer. The
following requirements should be met to ensure proper instrument function.

3.1. Installation Requirements
Location Place the system in an area where it is easy to operate and easy to connect to the instrument.

Surface Prior to unpacking, ensure that the work area for the instrument is a solid, level surface that can safely
support the weight of the system.

Size Minimum dimensions for the work area are 36.5 inch (93 cm) width x 36 inch (91 cm) height x 24 inch (61 cm)
depth clearance.

Environment The work area must be in an environment with an ambient temperature between 18°C-26°C (64°F-
79°F). The area must be properly ventilated with a maximum relative humidity of 80% for temperatures up to
31°C; Pollution Degree Il or less. The equipment will produce less than 85 decibels at peak operation.

Power source The instrument and computer must be connected to a 120V/240 15A supply with grounding (3
prong). It is recommended to use a dedicated power source to prevent interference from other instruments or
equipment. It is also recommended to use a UPS (uninterruptible power supply) with minimum 1500VA. This will
help to prevent unexpected system failures due to an unstable power grid system or in the event of a temporary
power outage.

3.2. Installation Instructions

Unpacking The system is packaged in a wooden crate mounted on a pallet. Unlatch all fasteners and remove the
lid on top of the crate first. Remove the computer, accessories box and label printer from the crate. Remove the
sides of the crate.

Installation Requires 2 people. Each person should pick up one end of the instrument and carefully lift it out of
the crate. Carefully move the instrument to the operating area and place it on the bench. Level the instrument
surface using a bubble level. Remove all packing material and the packaging securing the robotic arm. Verify that
all axes can move freely before operating the instrument. Unpack and install the computer and accessories.

Hooking up Connect the USB cable from the designated port on the computer to the back of the instrument.

‘@ A Do not plug and unplug the USB cable while the PC or Instrument is on.
***Always turn off the instrument and PC before plugging and unplugging the USB cable.

Connect the Computer to the power source or UPS. Follow the instructions on the UPS, as some may require
powering up for several hours to charge the internal battery. Using a standard IEC320 compatible power cord,
connect the AC power port at the rear of the instrument to the power source or UPS.

Cut the waste tubing to size and route to the waste bottles on the floor. The ideal configuration is straight down to
the waste bottle to minimize the chance of overflow and waste buildup.

Avoid immersing the waste tubing in the waste bottle or flattening and kinking the tubing as this
may disrupt the gravity fed drainage and result in waste overflow.

ONCORE Pro X, Operating Manual, Rev. L 15



Starting up Turn on the instrument and computer.

Power on the power supply switch on the back of the instrument.
Power on the Slide Stainer by pushing on the power button at the front of the instrument. Q

Log in to the computer.

Default User Name: PathCom

Default Password: 6747/

Note: The user may change the computer user name and password after initial log in.

Disable the Wi-Fi radio and local internet connection (if applicable).
This feature may cause unexpected crashes during instrument operation.

A The internet access should only be enabled for a remote support session, email communication or
web conference call. Disable the internet access while the instrument is in operation to prevent
unexpected crashes.

Disable automatic time synchronization.
This feature may cause unexpected crashes during instrument operation.

For Windows 10 systems: Configure Time & Language settings within Windows Settings.
Toggle Off the Date and time options as shown.

Set time automatically
® ) of

Set time zone automatically

@ o

Figure 6

A Do not change the Windows Settings without consulting Technical Support, as this may cause
unexpected crashes and performance issues. This includes settings for input language, OS language,
region, regional formatting, power options, Windows Update etc.

Setup the barcode label printer.

Load the ribbon and media according to the manufacturer’s instructions.

Connect the printer to the designated port on the computer and switch the power on. The printer driver will
automatically install within a few minutes.

Calibrate the media, if needed, using the Zebra Setup Utilities.

The on-site field representative will perform the necessary system checks on robot, modules, and pumps.
Contacts for Assistance

Customer Service: 925-603-8000

Technical Support: 1-800-799-9499 Opt. #3

Replacement of Consumable Materials

Replacements for all consumable materials can be obtained from:
Website: www. biocare.net
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Section 4. Instructions for Use

This section provides the instructions for daily routine operation of the instrument.
Please check all Requirements p.7 before beginning instrument operation.

4.1. Starting Up the Slide Stainer

Turn on the Slide Stainer using the power button and then turn on the computer.
Note: It is important to follow this exact power on sequence.

Double-click the shortcut for the Oncore Pro X Automated Slide Staining System Ul ﬂ to access the login
screen.

Select “Yes” when prompted by Windows User Account Control to grant access permissions.

“Do you want to allow this app from an unknown publisher to make changes to your device?”

PCStainer.exe

Login to the main user interface.
Default User ID: Supervisor
Default Password: Supervisor

AN — %
CNCORzZem V4213302

UserlD “

Password ‘

Enter

Figure 7
Refer to Security, p. 83, for information on managing User IDs and Passwords.
Close the door of the Slide Stainer and click “Enter” to access the Main screen and begin system initialization.

The system will take a few minutes to verify all connections between the instrument and the computer, and then
home the robotic arm, modules, and pumps.

Progress Status

System Initialization

Figdre 8
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Tip: If the system fails to start or is stopped/interrupted while performing a task, re-initialize the system and try

again. Refer to Perform System Initialization, p.53, for more information.
An interactive slide map corresponding to the 36 slide positions is displayed on the Main screen.

1/6/2022
Scan Assign Sean System Clean
1 2 - 30 P M Slides Protocols | Reagents  Utiliies Screen

AR = Load
PRO]
CNCORZem Tf:g;;e Linkoed (o

Slides

V4213302

Figure 9

All routine functions are readily accessed from the Main screen. To perform a typical run, click:

Prepare Labels to print labels for slides. Each label is printed with a 2D barcode required to identify the slide.

Load/Unload Slides to lift and lower lids for inserting and removing slides.

Auto Start to automatically start the run after loading the labeled slides and tagged reagents.
Scan Slides to scan the barcode labels on the slides.

Assign Protocols to manually assign a protocol to a slide.

Scan Reagents to scan the RFID tags on the reagent vials.

System Utilities to access additional features and utility functions.

Clean Screen to clear the slide map.

Exit to close the application.
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4.2. Preparing and Printing Labels

From the Main screen, click “Prepare Labels” to open the Slide Label Editor:

Slide Label Editor

Select All Add Print Move To Printed Slides Delete

Return

Printed Slides Patient ID Case Number NM Block ID
Scanned Slides
Processed Slides

Specimen
Tioe Protocols Date Doctor Name

Figure 10

Labels available for printing are listed on the screen under New Slides.
A. Select New Slides to create or view new labels.
Select Printed Slides to review or reprint a label.

B.
C. Select Scanned Slides to review labels that have already been scanned.
D. Select Processed Slides to review labels that have already been processed.

Add New Labels in the Barcode Editor

Labels must be prepared in the Barcode Editor and added to the Slide Label Editor before they can be printed.

To add new labels to the Slide Label Editor, click “Add” to open the Barcode Editor.
Enter the Patient ID, Case Number, and other required label information* into the designated fields.
/A Note: caret A and tilde ~ characters are not permitted in the entry fields.

Barcode Editor - Add

PatientlD |PatientA Date Time |12:41:39PM g
Case Number 123456 | BlockID [4A

Specimen Type |Tissue X Doctor | DoctorC v
Hospital Name Description

Hospital F testlabel

Custom Group
None v

Available Protocols Selected Protocols
Bcl-2 Extras ~
Bcl-6

CD10 Extras

Add With:
CD117Rb [ Positive

CD138
CD15
CD20
cD21
CD23
CD34
CD56 Add
CcD7

CDX2

CEARb Remove
CK19

CK20 v

[] Negative

Save Return

Figure 11

Next, add protocols to the list of Selected Protocols:

ONCORE Pro X, Operating Manual, Rev. L

(Optional) Select the Date Time of the label.

(Optional) Select the name of the Doctor from the
dropdown list. To add new names to the list, refer to
2D Barcode Format p. 84.

(Optional)* To print the “Block ID” field to the slide
label, the user must change the default label format.
Select “Container Identifier” from the drop-down list
in the desired field of the Label Formatter.

Note: The information entered may not be printable
due to the size constraints of the label. Use
abbreviations as needed or select a different label
format. Protocol Name, Patient ID, Date, Case
Number, Hospital Name and Description are printed
on the label by default. To change this setting, refer
to 2D Barcode Format p.84.
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To add protocols to the Selected Protocols, select protocol(s) from the list of Available Protocols and click “Add”.

Tip: The user may search the list of protocols by typing the first few letters of the protocol name. Click “Save” to
generate new labels for each protocol in the list of Selected Protocols.

Barcode Editor - Add

PatientD [PatientA

Custom Group

Date Time |12:41:39 PM

Case Number :123456 | BlockID |4A
Specimen Type |Tissue X | Doctor | DoctorC
Hospital Name Description
Hospital F [lesllabsl

None

Available Protocols

HPV 6 Probe
Kappa Probe
Ki67 Rb
Lambda Probe
Mammaglobin
MLH-1 Extras
MSH2
MSHé6

40 Extras Special
p
Pan CK Plus
PAX-5 Extras
PAX8
PR
RNA-Probe
RNA+ Probe

Save

Selected Protocols
CD20

CK7

p63

Add With:
[] Positive

[] Negative

Add

Remove

Return

Tl

Figure 12

Alternatively, the user may use a customized sublist
of available protocols by selecting a custom group
from the Custom Group drop down list.

Custom Group

o .'

custom group 1

custom group 2

custom group 3
Figure 13

Refer to Creating Custom Groups, p. 81, for more
information on creating custom groups

To remove protocols from the list of Selected Protocols, select protocol(s) from the list and click “Remove”.

(Optional) To add a positive and/or negative control to the Selected Protocols, select the protocol and check the
boxes Add With: Positive and/or Negative, and click “Add”. Click “Save” to generate new labels.

Barcode Editor - Add

PatientD [PatientA

Case Number :123456

Hospital Name
Hospital F

Custom Group

Date Time [1241:39PM
Block ID [4A

Specimen Type |Tissue X | Doctor | DoctorC

Description
[lesllabsl

None

Available Protocols

Bcl-2 Extras
Bel-6

CD10 Extras
CD117Rb
CD138
CD15

cD21

CD23

CD34

CD56

cD7

CcDx2
CEARDb
CK19
|CK20

Save

Selected Protocols
CD20

CD20+
CD20-

Add With:
[ Positive

] Negative

Add

Remove

Return

Figure 14
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Refer to Assigning Negative Controls, p. 78, for more
information on assigning negative controls to
protocols.

Add With:
Positive

Megative

Figure 15
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(Optional) To add an entire panel of protocols to the Selected Protocols, select the custom panel from the list of
Available Panels and click “Add”. All protocols assigned to the panel (including positive and negative controls) will
be added. Click “Save” to generate new labels.

Barcode Editor - Add The user must first create a custom panel before the
Available Panels field is made visible in Barcode

PatientlD [Patient B |  DateTime | 4:2032PM 3~ | Editor

Case Number | B\ocle:

Specimen Type Doctor  Doctor A ~

Hospital Name Description

Available Panels

Hospital F testlabel
Custom Group

None v

Available Protocols Selected Protocols
Bcl-2 Extras ~ Ki67 Rb

Bcl-6
CD10 Extras PN ERRb Figure 17
CD117Rb O Positive  |Ki§7 Rb+ 9

CD138 Ki67 Rb-
CD15

cD20 v Refer to Creating Custom Panels, p. 81, for more

Available Panels information on creating Panels.
panel 2 Add
panel 3
panel 4

[] Negative

Remove

Save Return

Figure 16

After saving the current labels, the user may continue preparing labels for the next case.
By default, the input patient information is retained in the entry fields for the next set of labels.
To change this setting, refer to 2D Barcode Format p. 84.

Click “Return” to close the Barcode Editor.

Print Labels in the Slide Label Editor

All unprinted label entries are listed under New Slides in the Slide Label Editors. This list is automatically sorted by
Patient ID; however, the user may sort the list by the column headers i.e.: Label No., Case Number, Block ID etc.

Slide Label Editor
~ Select All Add Print Move To Printed Slides Delete Return
No. Patient ID Case Number NM  Block ID ?x"“’” Protocols Date Doctor Name iy Description
» [ Patiena 123456 13 |aa TissueX | CD20 1/6/2022 1241 PM | Doctor C HospitalF | testlabel
2 | Patient A 123456 23 |4A Tissue X cb20 +1/6/2022 1241 PM | Doctor C Hospital F test label
3 [ Patient A 123456 33 4A Tissue X CD20- 1/6/2022 1241 PM  |DoctorC Hospital F testlabel
Figure 18

To print labels from the Slide Label Editor, select the label(s) or “Select All” using the checkbox, and click “Print”.
Note: Label entries are automatically removed from the system after 30 days from the date assigned on the label.

To delete a label from the Slide Label Editor, select the checkbox and click “Delete”.
Note: Once the slide label(s) have been printed, slide processing is initiated and the slide information will be

distributed to all instruments on the Network. The label entry can no longer be deleted.

Refer to 2D Barcode Format, p. 84, for information on adjusting printer settings and label format.
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Move Slides to Printed Slides (for use with LIS only)

The instrument can be configured to recognize slide labels generated from an external source when integrated
with an LIS system. Note: The 2D Barcode reader must be configured to recognize labels of different formats. Please
contact Technical Support for more information.

Slide Label Editor

MUCUEIEEE || [ SelectAll Print Retumn

New Slides
Hospital

Printed Slides Patiert ID Case Number NM  Block ID $f;f”‘5” Protocols Date Doctor Name Name Description
Scanned Slides
Processed Slides L] Patient A 123456 13 |4 Tissue X cD20 1/6/2022 1241PM | Doctor C HospitalF | testlabel
2 [J|Patient A 123456 23 4A Tissue X CcD20 + 1/6/2022 1241 PM | DoctorC Hospital F testlabel
3 [1|Patient A 123456 33 4A Tissue X CD20- 1/6/2022 1241 PM |DoctorC Hospital F test label
Figure 19

The LIS system sends the processing order directly to the system computer. The ordered slides will appear under
New Slides in the Slide Label Editor. The user has the option to 1) print the slide label(s) to initiate processing, or
2) directly move slide label(s) to Printed Slides to initiate slide processing without printing, or 3) delete the slide
labels to cancel the order.

To manually move pre-printed labels to Printed Slides (without printing), select the label(s) using the checkbox and
click “Move To Printed Slides”.

4.3. Loading Slides and Installing Chambers

From the Main screen, click “Load Unload Slides” to raise all module lids.
Peel the labels from the label roll and affix them to the frosted side of the slide.
Slides are loaded individually onto each module.

For slides that must be baked prior to staining, refer to Prepare Slides with Baking Slides Function p. 49.
Refer to Slide Specifications, p. 29, for more information on tissue location recommendations for slides.

Load/Unload Slides
Verify that the heating plate and module surfaces are clean and dry before loading a new slide.

To load a slide onto a module, insert the slide into the hinge slot and then lower it onto the heating plate until it
locks in place under the front clip. If needed, adjust the slide so that it is centered over the heating plate.
Click “Slide Lids Down” to lower all module lids.

Tip1: If the slide is too difficult to insert, clean the hinge area
to remove any salt or debris.

Tip2: The hinge contains springs to accommodate minor
differences in slide length. However, if the slide is too long,
the front clip can be adjusted by loosening the two screws
with a small screwdriver.

Figure 20
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To unload the slide from a module, push the slide against the hinge slot until it is released from under the front
clip. Carefully lift the slide out, keeping it horizontal to prevent excess buffer from spilling onto the module
surfaces.

Transfer the slide to a slide rack and rinse it with distilled water before post treatment.
Wipe the heater, hinge slot, and other affected module surfaces with a moist paper towel to remove any staining
residues, then blot dry.

Install/Remove Chambers

Chambers are installed individually onto each module. They should be removed from the module for routine
cleaning and inspection to maintain optimal staining quality. Refer to Daily Maintenance Recommendations, p. 103,
for more information.

TN

r
‘a
e

~~

. -

point to press and remove chamber

Figure 21

To install the chamber, slide the chamber into the recess under the module lid and push up on the chamber until it
locks into place. Verify that all 4 corners of the chamber sit flat in place.

Tip: Push up on the underside of the chamber surface to verify the integrity of the chamber gasket. If the chamber
gasket is loose or damaged, it is time to replace the chamber.

To remove the chamber, gently push down on the chamber to unlock it from the module lid. Transfer the chamber
to a container for cleaning.

Tip: After completing a staining run, gently wipe the chamber surfaces with a lint-free alcohol wipe to remove any
staining residues/debris that may adhere to the chamber.
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4.4. Assigning Protocols: Scan Slides and Manually Assign Protocols

To automatically assign protocols by scanning labeled slides, close the door and click “Scan Slides” on the Main
screen. The system will automatically scan all 36 slide positions and assign the protocol(s) of labeled slides to the
appropriate position on the slide map. Refer to Editing Protocols, p. 71, and Change Protocol Template, p. 71, for
more information on generating protocols.

GNCORE Pro X System Software

I ile g 22022
CNCOR=em Prepare uL.:::d P Scan Assign Scan System Clean =
Labels A 11:16 AM 59 Foucols Resgents | Uiises || Scisen
Va213302 -
‘ B 6 7 s s n 1
s 2 = 3 5 3 s 5 34 3 3
w2 w2 co2s.
Patsent Patient Patient
A A A
Qs Logs: 134 00t of 200 sides and 8 tofal nne since last tubing clean
[1194.01 AM. Intiakzing hardware. ~
11:14:08 AM: Reading sampie barcodes.
11:14:19 AM: Done
11:14:20 AM: System s ready. =
Figure 22

Tip: Click + drag on the slide map to select specific slide positions to scan.

22222277

Figure 23
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To manually assign protocols to unlabeled slides, click + drag on the slide map to select the slide position(s). The
slide position(s) will be highlighted and display “????22???":

oed 112412022
Unload | | Auto Start

= 6:39 PM ==

Exit

Clear Select

2 otak s s st g clean

Figure 24

Click “Assign Protocol” to open the Select Protocol screen.
A. Click to select Normal to access the list of normal protocols.
B. Click to select Negative to access the list of negative control protocols.
C. Click to select All to access the list of all protocols.
Scroll through the protocol list, highlight the desired protocol, and click “Select” to assign the protocol to the

highlighted slides.

Tip: The user may quickly scroll through the protocol list by typing the first few letters of the protocol name.

Click “Clear” to cancel the selection and close the window.

ONCORZem"  pepsee
Label

12472022
Sean Assign Scan System Clean =
ides | [ Prolocols [ Reagents  Uliites Screen

Load [
G || s 6:40 PM -

Logs: o1t of 135 s and 2 total e snce last b clean

Figure 25

To clear the protocol assignment(s), click + drag to highlight the slide position(s), and then click + drag once more
to remove the assighnment(s). Alternatively, click “Clean Screen” to clear the entire slide map.
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4.5. Loading Reagents

Detection kits, ancillary reagents and antibody/probe products are shipped ready-to-use.
Refer to the manufacturer’s Datasheet and SDS for specific instructions.

Prepare all other reagent solutions following the manufacturer’s instructions.
Note: Only Oncore Pro reagent vials are compatible with the instrument. Refer to the vialing specifications in

Vialing Reagents, p. 29, for additional information on vialing and recommended reagent volumes.

Load the reagent vials onto the reagent rack and remove all caps.
Note: The user may roughly assess the reagent volume remaining in each vial using the volume indicator lines

located along the side of the vial. The required reagent volumes for the run are displayed on the right side of the
Reagent Check screen. Refer to Reagent Check: Scan Reagents, p. Error! Bookmark not defined..

CAUTION! Evaporation will cause gradual loss of volume within the reagent vial. Avoid leaving the reagent vials
open for a prolonged time. Close all caps and refrigerate reagent vials immediately after use.

1 n 7

g 13 g 13
e - =t S
i1 I
" \ ~b
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evaporation % evaporation

— > y 0, ) — ( >\ r": ‘r
AV 84 (A

Figure 26
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Please note that the reagent volume may be significantly reduced by evaporation after performing several
overnight runs and/or after performing multiple runs using the same reagent vial. This particularly impacts
antibodies that are not routinely run on the system (consuming only 1-2 tests per run over 20+ runs). Under such
circumstances, the reagent vials will empty prematurely or trigger a low volume warning before the RFID test
number reaches 0. To minimize evaporation in such cases, users should attempt to aggregate slides sharing the
same antibody/protocol to run those slides in larger batches over a reduced number of staining runs. Meanwhile,
users should monitor the test volume and refill/reprogram those affected vials if the volume becomes too low.

ONCORE Pro X, Operating Manual, Rev. L 26



Verify that the vials are fully inserted into the rack and oriented correctly, as shown in the figure below.

A. Forready-to-use reagents, place the reagent in any position on the rack.
B. For on-board mixing reagents, place the two mixing components on the rack, A and B. Avoid placing the
second mixing component, B, in the last two rows of the rack as the Z2 probe cannot reach it.

Red 0 3 420 3
210 0

Fast Red Chromogen |0 3

Il be picked up by Probe2,
ition 34. Please place
 then rescan

Legend ‘ Not Used H Insufficient “ Expired “ Missing

ReagentFile Name: | ReagentTagDataxml Loat

Scan
Reagents

Figure 27

Note: On-board mixing reagents, such as Fast Red
1:1, are specially formulated to be mixed directly on
the slide:
A. The first mixing component, i.e.: Fast Red
Substrate, is applied with the Z1 probe.
B. The second mixing component, i.e.: Fast Red
Chromogen, is applied immediately
afterwards with the Z2 probe.

The Z2 probe is specially designated for dispensing
the second mixing component; therefore, those
reagents, such as Fast Red Chromogen, can only be
loaded in reagent rack positions #1-30.

C. For on-rack mixing reagents, place all mixing components A and B (and C if applicable) on the rack.
Additionally, place an empty mixing vial (7mL or 15mL) in designated position, ie: #40, as prompted by the
system in the Reagent Check screen.

39 28
DAB

36 Tests

202202
7 m1)

DAB 0 3* 776 36
DAB Buffer 0 ] 7725 []
DAB Chromogen 0 38 483 0

Legend: ‘ Not Used ” Insufficient “ Expired

ReagentFile Name: | PutReagent File Name Here Load

Scan
Reagents

Figure 28
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Note: The system will consume extra tests of each
reagent component to fill the dead volume of the

empty mixing vial or to fulfill the minimum mixing
volume requirement.
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Multiple vials of the same reagent may be placed on the rack.
The system will prioritize the use of vials with the earliest expiration date or the least number of tests remaining.

Refer to Reagent Consumption Priority, p. 88.

Load the reagent rack onto the designated reagent plate on the instrument.
Verify that the rack is fully seated on the plate, and is oriented correctly, as shown in the figure below.

Figure 29
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4.6. Vialing Reagents

The system provides user-fillable reagent vials for special reagents, uncommon antibodies, and custom ab titers.
Each vial is packaged with an RFID tag, cap, and a blank label.

Use of unauthorized reagents on the system may cause damage to instrument components and will
revoke the manufacturer’s warranty.

The clear vial option is designated for general use.
The dark vial option is designated for light-sensitive reagents such as probes and chromogens.
Contact Customer Service for ordering information.

7mL Reagent Vial Specifications

%E 4 The 7mL vial is specially designed for efficient use of antibodies and probes by
—rrtd é minimizing dead volume.
'-It i Max capacity 9mL.

The dead volume for a 7mL vial is ~250ulL.

Note: Although the 7mL vial can hold up to 9mL, it is recommended to fill below
7.5mL to avoid triggering liquid volume errors.

y f =

) 1]

F

A N4
Figure 30.

15mL Reagent Vial Specifications

The 15mL vial is designed to hold larger volumes of reagent.
Max capacity 16mL.
The dead volume for a 15mL vial is ~1000uL.

Figure 31

Instructions for Use

Fill the reagent vial with the appropriate amount of reagent solution.

Tip: Use the Reagent Check screen to quickly obtain a list of required reagent volumes, then add 1mL dead volume
for a 15mL vial or add 250uL for a 7mL vial.

To calculate the required volume:

Volume = number of tests* x protocol volume x draw factor 1.08** + dead volume*** of the vial

Notel*: It is advised to fill a lower number of tests per vial for reagents that are volatile or less chemically stable,
and for reagents that are not routinely used.

Note2*: An additional 8% extra volume (or more) is required to compensate for reagent evaporation and the
amount adhering to the internal surface of the tubing and external surface of the aspiration probe.

Note2***: The reagent volume may be significantly reduced by evaporation over several overnight runs or over
multiple staining runs. In such cases, users may need to increase the dead volume or refill vials more frequently.

Label the reagent vial and cap.

Program the RFID tag. Refer to Preparing RFID Reagent Tags with the RFID Tag Editor, p. 78, for more details.
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4.7. Managing Buffer and Waste

The system will prompt the user to verify the required Wash Buffer and Waste Container volumes before
proceeding with the staining run.

Refill the Wash Buffer Container
The standard Wash Buffer Container has a maximum capacity of 2000mL.

The buffer container is stored on the inner left housing structure.
Click System Utilities>Tools>"Move Arm to Middle” to safely move the robotic arm aside to access the buffer.

System Utilities
Tools Editors Security Settings Network LIM
Baking Slides Initialize System —
Load Slide Map File Check Modules
SP1-Z1 Calibration Prime Z1and 22
SP1-Z2 Calibration Prime Pump Z1
Barcode Calibration Prime Pump Z2
Tubing Clean Lock Door
Tubing Clean Log Unlock Door
Move Arm to Middle Backup Report Data
Figure 32 Figure 33

Disconnect the buffer container and carefully remove it from the instrument. Avoid making contact with the
robotic arm or deforming the buffer adapter tubing.

Refill the container with fresh buffer, then reconnect the buffer container and place it back onto the instrument.
Clean up any leaks or spills.

Click System Utilities>Tools>”Prime Z1 and Z2” to prime the inline tubing, then visually inspect the lines to ensure
that air bubbles are not present.
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Empty the Waste Containers
The standard Waste Containers have a maximum capacity of 4000mL, with a secondary containment provided for
each waste container.

The waste containers are stored underneath the instrument, fed by gravity through the waste tubing.
Click System Utilities>Tools>”"Move Arm to Middle” to safely move the robotic arm aside from the waste stations.
Carefully pour some water through the waste stations to flush out the waste tubing.

o B ———
i}l

Figure 34

Disconnect the tubing from the Waste Container caps and empty the waste containers.
Dispose of the waste according to local regulations.

Reconnect the waste tubing: the black tubing is designated for hazardous waste and the blue tubing is designated
for non-hazardous waste.

Verify that the waste tubing is draining properly, making sure that the inserted end of the tubing clears the
maximum waste level line. Adjust the angle and free length of the tubing as needed.
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4.8. Reagent Check: Scan Reagents

@ A Remove all reagent vial caps before proceeding.

From the Main screen, click “Scan Reagents” to open the Reagent Check screen. The reagent map is displayed on
the left and a table of reagents required for the run is displayed on the right.

& Reagent Check - X
1 2 3 4 5 Numberof  Voume  Number of
Reagent Name Reagent Postion Teis  Roqied  Tess  CRMEGL Remarks
Requred  W)x108%  Scamned

Ds1 0 EJ 92 0 0

05250 0 ® 776 0 0
€ 7 2 i e AR1, high pH 0 % 14400 [l [

Bo6 0 ® 5040 0 [

Mouse HRP 0 E3 5040 0 [

DAB ) 3 7778 E3 202202 On Rack Miing
" B - 1o 15 DAB Buffer 0 ] 7725 0 0 ReagentA for mieng DAB

DAB Chromogen 0 E] 433 0 0 Reagent for mhang DAB
15 7 18 1 20
21 2 23 2 25
2 27 5 3 30
31 E 3 32 35

e AEE  ETE 2w

ReagentFile Name: | PutReagent File Name Here LoadReagentMapFile | | PrintRequired Reagents
35 B 3 )

)
2o T o Start DelayStat | Retumio
202201 Feors Staining Staining Main
a my © Process Pracess Screen

Figure 35

Tip: Click “Print Required Reagents” to print the list of required reagents. A network or USB printer is required.

o) Report Reagent List - m} ®
1 of 1 @ & B - | 100% - Find =
Required Reagent List
2/1/2022 4:06:21 PM
Reagent Name Reagent Number Volume Number Expiration Remarks
Position Of Tests Required Of Tests (YYYYI
Required (ul) Scanned

DSt 1 3 T 47 202307 BIOCARE
MEDICAL, 1

DS2-50 2 3 648 47 202307 BIOCARE
MEDICAL, 2

AR2, low pH 3 3 1200 31 202307 BIOCARE
MEDICAL, 3

CcD20 6 3 420 68 202307 BIOCARE
MEDICAL, 4

Mouse HRP 5 3 420 97 202307 BIOCARE
MEDICAL, 5

DAB 40 3 648 3 202202 On Rack Mixing

DAB Buffer 7 5 1016 55 202307 ReagentA for mixing
DAB
BIOCARE
MEDICAL, 6

DAB Chromogen 4 5 64 55 202307 ReagentB for mixing
BIOCARE
MEDICAL, 7

1of1
Figure 36
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To scan all reagents with the RFID reader, close the door and click “Scan Reagents”. The robotic arm will move the
RFID reader antenna over each reagent vial position and read out the stored RFID tag information. The system will
continue scanning until all required reagents have been detected or all 40 positions have been scanned.

Tip1: Click + drag to select specific reagent vial positions to scan.

Tip2: Click “Stop” to stop the scan while it is in progress.

o Reagent Check - X
- . Tou o ouse
So Tests 6 Tests 34 Tests 68 Tests 196 Tests e Feagert Postion L, eied  Tes, OYYYMM) Fematks
207307 202367 202367 202307 202307 :
EOBAE200  EG028208  EQR49l00  EGAME208  F@D4B200
S4BEAD7S 54045560 SABEAFED  S5260E47  54913DA0 os1 ! 3 bz 2 202307 |BIOCARE MEDICAL 1
= = 05250 2 3 73 50 202307 BIOCAREMEDICAL, 2
4 048 Universal ¢ 1 AR2.JowpH 3 3 1200 £ 202307 BIOCARE MEDICAL 3
08B Buffer Lo
80 Tests [T ST €02 4 2 280 1] 202307 BIOCARE MEDICAL, 4
orcos. 60 Tests 169 Tests
202307 202367 Mouse HRP 5 3 2 100 202307 BIOCAREMEDICAL 5
EOBAC200  pipagame  E@edadce
50915807 gooctitl  asacces DB 0 3 o8 3 202202 On Rack Miing
S . ReagentAfor mixng DAB
1 12 5 1 15 DAB Buffer 6 5 1016 & gy S
Reagents for mixing DAB
DAB Chromogen 7 5 5 ) 20237 | HeegertBior g DA
Universal Negalive 8 1 140 100 202307 BIOCAREMEDICAL, 8
15 7 15 1 2
21 2 2 2 25
b 27 2 3 30
E E 33 38 35
e ETEL O ETE Bl T
Reagent File Name: | ReagentTagDataxml Load ReagentMap File | | Print Required Reagents
35 37 E ) 20
a8
22 — Start DelayStat | Retumio
202202 Tl Staining Staining Main
any £ Pracess Process Screen
Figure 37

The scanned reagent assignments are displayed on the reagent map on the left.
Each scanned reagent vial will be displayed with the following:
A. Reagent name.
B. Number of tests remaining. Updates during the staining process each time reagent is aspirated.
C. Expiration date.
D. Unique RFID tag ID. Provides traceability for the individual reagent vials across different runs.
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After completing the scan, the system will display the current status of the reagents:
A. All expired reagents are highlighted in brown and must be replaced.
All missing reagents are highlighted in pink in the reagent list.
All reagents with insufficient number of tests are highlighted in yellow.
All reagents ready for the staining run are highlighted in green.
All reagents not used will remain with a white background.
All RFID tags that produced an error during scanning are highlighted in red and must be replaced.

mmooO®w

55| Reagent Check - x

L umberof  Volume

jolume. Number of
Requed Tests

Reagert Name Reagert Position Tests
Requred  (i)x108%  Scanned

2 3 4 H
D556 AR2. low pH D20 Nouse HRP
50 Tests 4 Tests 1 Tests 100 Tests
262307 262307 282307 262387

EG623260  E004BI00  EG04B28D  EGBAE200
54045560  SABEAFED 54027861  54018DAD

7 18

D52:50
AR2, low pH
CD20

0 k
2
3
4
Mouse HRP 5
[}
[]
0

i
1200
280
120
618
1016
6
10

202307
202307 BIOCARE MEDICAL 2
202307 BIOCARE MEDICAL 3
202307 | BIOCARE MEDICAL 4
202307 BIOCARE MEDICAL §
202202 | On Rack Miing

0 ReagentA for mixing DAB
202307 | ReagentB formixing DAB
202307 | BIOCARE MEDICAL 8

088 Butrer e
7 Tents Nesetiie
frg s

Sers)

05
Chromogen
P o Tests
£0049200
54918936

8

£06£0208
5451CC98

DAB
DAB Buffer

DAB Chromogen

Universal Negative | 10

1 12

ST PR e e
zcclwz~gas

8

282212
£B040268
S4BEELL
15 17 18 18

x

2 2 . 2 Reagent Information in RFID tag E004020054%1A3C7 was not
updated correctly. This mistake may happen in a previous
staining run. To continue use this reagent vial, one must

correct its reagent information with RFID Editor.

FEEFTEECEET T
Reagent File Name: | ReagentTagData.xml Load ReagentMapFile | | PrintRequired Reagents

36 38 3 40
5 s Start DelayStart | | Retumto
can
202282 Resgonts Staining Staining Main
gR Process Process Screen

Figure 38

The user must add additional vials when the reagent is insufficient or missing. Up to 5 vials of the same reagent
may be placed on the rack. Manual assignment or a re-scan of the reagent rack is required to proceed.

Note: A warning will appear when insufficient reagent is detected. Additional tests may be added either by
1) refilling the reagent vial and reprogramming the test number, or 2) adding additional vials of reagent.
Upon re-scan, the reagent will highlight in green once the test number is found to be sufficient.

The user may need to reprogram or replace the RFID tag when the reagent is not scanned properly.
In such circumstances, users must manually verify the volume remaining in the vial to determine the actual
number of tests left.

A. Not Exist. The scanned reagent name does not exist in the system.

B. Data Read Error. The RFID tag failed to scan correctly.

C. Tag Not Updated. The RFID tag information was not updated correctly in the previous run.

D. RFID tagis not found. The RFID tag failed to scan completely.

Note: Contact Technical Support for help troubleshooting recurrent cases of RFID misreading or failure, as this may
indicate an issue with the system’s RFID Reader system.

For more information on reading and writing RFID tags, refer to Preparing RFID Reagent Tags with the RFID Tag
Editor p. 78.
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To manually assign a missing reagent to the Reagent Map, select the missing reagent in the table on the right,
then click a position on the reagent map to assign the exact number of tests required to this reagent rack position.

A Note: The user has the capability to manually assign missing or insufficient reagents; however, it is
recommended to reserve its use only in the case of an RFID reader or RFID tag failure. Manually assigned reagents
cannot be tracked by the system, so it will be the user’s responsibility to keep track of the vial contents and gauge
the number of tests remaining.

6 Reagent Check

s Nomberof  Volme  Numberol g
abise G Reagent Name Reagert Postion Tests Requred  Tets  (oful Remarks
X102 Scanned

2 3
D52-56  AR2. low pH (D26
58 Tests 34 Tests 1 Tests 180 Tests Requied

262307 262307 282307 282307
EG020200  EGD4B280  E00B200  EGBED20E
54945589  S4BEAFED 54327361  54913DAS

- - 05250 2 3 648 50 202307 BIOCAREMEDICAL, 2
oo B 045 Universal | |ARZlowpH 3 3 1200 3 202307 BIOCAREMEDICAL, 3
4B Butfer Chromogen Negative
4 Tests 180 Tests
g 202167 202307
oaay  Eesa0200 6828280 Mouse HRP 5 3 420 100 202307 BIOCARE MEDICAL.5
4960108 s4siccos DAB 0 3 643 3 202202 On Rack Mising
38 Tests
202
£9828260
feoscace Universal Negative 10 1 140 100 202307 BIOCAREMEDICAL, 8
15 7 it 19 2
E2 2 23 2 5
25 27 2 2 S

31 Y 3 3 35
papeeEE - OETE e e
Reagent File Name: | ReageniTagDataxml Load ReagentMap File | | Print Required Reagenis

- - Start DelayStat | Retumio
202200 e St Staining Staining Main
) g Process Process Screen

Figure 39

The manual assignments will be saved until the reagent rack is scanned again.
G. All manually added reagents are highlighted in dark green.

7§
@A Always verify that the manually assigned reagent is placed in its corresponding position on the
Reagent Rack and that it has sufficient volume before proceeding.

To review a previously run Reagent Map, click “Load Reagent Map File”, and select the map file from the list of
reagent map logs. Each log is labeled with the date and time of the run. Open the log and it will be displayed on
the reagent map on the left.

1 2 4 Numberof  Volme  Numberof
Reagent Name Reagent Postion Teis  Remimd  Teds  CEOLE Remarks
Requred  ()x108%  Scamned
Ds1 3 d
05250 3 648
€ 8 e AR2.low pH 3 1200
€02 20
| Mo ¥ Open X
DA
< Logs » ReagentTagData v
2 1 * g gentTag
| Organize Newfolder =
o A Name -

agentTagData-2021-11-16-03-33-Endx.
agentTagData-2021-11-16-03-39-Start..
gData-2021-11-16-10-12-Endx,
gData-2021-11-16-10-12-Start..

hu-HU eta-cuet- 1l e
2 2 25
[ Re ata-2021-11- art..
it

. . o e

T a
Re ata-2021-11-17-06-44-Start..
e [ ReagentTaqData-2021-11-17-11-16-Endx

2 2 2 2 3 Logs [ ReagentTagData-2021-11-17-11-16-Start.
entTagDiats-2021-11-18-03-55-Endix.

Blsels
Elslals

HER

R
ooood
77700

HL7Conne

ResgentTa |

31 B 33 s 35
35 37 35 33 @
G Start DelayStat | Retumito
St Staining Staining Main
Reagents
Process Pracess Screen

Figure 40
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4.9. Starting the Run

To immediately start the run, close the door and click “Start Staining Process” from the Reagent Check screen.

A Verify that all caps have been removed from the reagent vials before starting the staining process.

Close the door before starting the run. The door will lock and block unsafe access to the instrument while it is
in operation. The staining run will not proceed while the door is open.

The system will initialize and lock the door, then proceed to calculate the most efficient schedule to complete the
staining run. Longer protocols are prioritized over shorter protocols to enable the slides to finish at a similar time.

ONCORE Pro X System Software

CNCORzZam" V5 2/172022 -
‘ 1:01 PM 8

V4213302

| Confirmation
|

[J Mute Alarm Cancel
25 2% 27 28 29 30 31 32 33 34 35 36
8 20 B
Patient Patient Patient
A A A
Status Logs 134 out of 200 siides and 8 total runs since last tubing clean
12:53:54 PM: Creating schedule A | [12:43:06 PM: Side: 3, Task: 1. Add Reagent, DS1 ~
12:59:56 PM: Intializing hardware 12:43:12 PM: Siide: 4, Task: 1. Extract Waste, DS1
13:01:10 PM: Run task [UnLock Doors] 12:43:17 PM: Siide: 4, Task: 1. Add Reagent, DS1
13:01:10 PM: Done. | |12:43:22PM: Side: 5. Task: 1. Extract Waste, DS1 %
Figure 41

Once all calculations are complete, the system will unlock the door and prompt the user to verify the volume of in-
line wash buffer and the remaining waste capacity.

A. The robotic arm will automatically move to the center of the instrument to allow the user to add
more buffer if needed.

B. The waste containers are located under the instrument work surface and should be emptied as
needed. Note: The calculated waste volume reflects the total volume of waste, combining both
hazardous and non-hazardous waste. In the event of an overflow of the non-hazardous waste station,
all waste will be dispensed into the hazardous waste container. Therefore, it is important to ensure
that both waste containers have sufficient capacity.

Refer to Managing Buffer and Waste, p.31, for more information.

Click “OK” to proceed with the staining process.

A The staining process will not proceed until the user completes this verification step.
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As the instrument prepares to start the run, the system will prime each pump three times over the wash stations
to fill the in-line tubing. A run timer will appear at the top of the screen, counting down the expected time
remaining until the end of the run.

1:10:47 PM
Time Remaining:

2:19:59

Figure 42

Tip: Runtime will vary depending on the protocol template(s) used and the run complexity (number of slides and
types of protocols selected). Selecting more slides and several protocols running multiple detection systems will
result in a longer runtime. To increase overall lab throughput, it is recommended to run shorter runs during the day
and save longer, more complex runs for overnight.

To delay the start of the run to a later date or time, click “Delay Start Staining Process” from the Reagent Check
screen:

Delay Start Slide Staining

Please set date and time that this slide staining process is
expected to finish.

Date: | 2/ 2/2022 ~| Time: | 800:00Y [5

Cancel OK

Figure 43

Enter the Date and Time that the run is expected to finish. The maximum delay start is 72 hours.

The system will calculate the delay time and initiate a countdown. When Time Left to Start reaches 0:00:00, the
system will automatically begin the staining process.

Delay Start Counting Down

Slide Staining Process Start Time:

2/212022 531 AM
Time Leftto Start: 16:29:20

Cancel

Figure 44

Tip: Use Delay Start on overnight runs to prevent processed slides from drying out.
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Gantt Chart

The current run schedule is displayed on the Gantt chart. This may aid in tracking the progress of the run and
determining the wait time for loading/unloading slides.

To view the Gantt chart, expand the AutoStainer Server window from the taskbar and click the Gantt tab.

ONCORE Pro X System Software
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Figure 45

The purple line tracks the progress of the staining run. The time is measured in thousands of seconds.
Tip: Hover the mouse over the bar to display the name of the task within the protocol.

Each bar represents a batched task for a group of slides. The maximum group size is 18.
1) The red bar represents a task corresponding to a reagent addition.
2) The blue bar represents a task corresponding to a quick wash using wash buffer.
3) The green bar represents a task corresponding to a quick wash using a reagent
4) The purple bar represents a task corresponding to an incubated wash.
5) (Special) The brown bar represents two linked tasks for mixing of 2 RTU reagents.

Sequential tasks are arranged horizontally on the Gantt chart following the sequence of steps in the staining
protocol. One or more tasks may be running simultaneously within the course of the staining run, based on the
grouping of the slides and protocols. Simultaneously running tasks (from different groups of slides) are arranged

vertically on the Gantt chart.

ONCORE Pro X, Operating Manual, Rev. L

39




4.10. Auto Start

The Auto Start feature may be used to start the staining process directly from the Main screen. The system will
automatically proceed from scan slides to scan reagents and skip the buffer and waste verification step to
immediately start the run. This may reduce instrument startup time.

This feature requires certain setup conditions for use:
A. The user has loaded all slides onto the instrument and labelled with a 2D barcode.
B. The user has loaded all required reagents onto the instrument and programmed the vials with RFID tags.
C. The user has verified that the buffer volume and waste capacity are sufficient.

To use Auto Start, close the door and click “Auto Start” on the Main screen and enter the number of slides loaded
onto the instrument.

Slide Scan *

Number Of Slides Expected to Scan BS =

Please check the reagent rack and remove all
caps before proceeding.

Please check the volume in the wash buffer and
waste bottle.

Cancel

Figure 46

4.11. Completing a Run

The system will remain locked while the staining run is in progress. Limited access is provided to prepare labels.

A In the case of an emergency, click “Exit” to abort the staining run. All run progress will be lost.

Please heed the following precautions while the run is in progress:

A Disable Wi-Fi and local internet connection.

A Do not attempt to log in/out of Windows or switch users while the instrument is still in operation. This will
cause a fatal system error and cause the system to crash.

Do not attempt to run other applications in the background when the instrument is in operation i.e.: Team
Viewer/remote control session, Windows Update, Internet Explorer, Antivirus etc., as it may result in an
unexpected system crash.

A Do not attempt to change file/folder settings or screen display/appearance settings when the instrument is
in operation ie: locking the Taskbar, as it may result in an unexpected system crash.

The Autostainer Server, Robot, Slide Processor, and RFID Processor Terminals will be running while the
instrument is in operation. Do not attempt to close any of these applications as it may result in an unexpected
system crash.

Figure 47
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Runtime Monitoring

While the instrument is running, the user may track the progress of the run from the Main screen. The slide map
displays all 36 slides and displays the protocol, time, and the current step at each slide position. A system log is
displayed at the bottom of the screen.

ONCORE Pro X Systern Software
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The system monitors the instrument for errors during the staining process. If it encounters any notable errors
during its operation, it will attempt to recover from the error and proceed to the next step. Any slide(s) that may
have been affected by the error will be marked in yellow and labeled with the step in which the first error
occurred. The user is advised to verify the staining results of potentially affected slides and review the Slide Report.
Please contact Technical Support if encountering persistent system errors.

A. The system monitors the heater temperature during the staining process. If a heater fails to heat or cool
down to the temperature set point, its position on the slide map will be marked in yellow and display a
“Low Temperature” or “Overheating” warning. The user is advised to perform a heater check after the
run to verify the heater function. Refer to Check for Module Malfunction, p. 53, for more information.

B. The system monitors the module function during the staining process. If a module fails, its position on the
slide map will be marked in red and display a “Module Malfunction” warning. The module will be
disabled and cannot be used again until the error has been cleared. The user is advised to perform a
module check after the run to verify the module function. Refer to Check for Module Malfunction, p. 53,
for more information.

C. The system verifies the liquid level in the reagent vial before drawing reagents. The Z1 probe is equipped
with a liquid level sensor. If a low volume or no liquid is detected, the system will mark all affected slides
yellow with a “Low Volume” warning. The user is advised to verify the volume in the reagent vial(s) after
the run to verify the error and identify potentially affected slides. Reagents that have low conductivity or
high viscosity cannot be reliably detected by the liquid level sensor. The system may show a low volume
warning for such reagents. In this case, the user may visually inspect the reagent vials to confirm that
sufficient volume was available during the staining run.

D. (If the Overflow Detection option is enabled), the system verifies the liquid level in the waste overflow bin

before dispensing waste. If liquid is detected, the system will alert the user of a potential overflow. When
an overflow is detected in the non-Hazardous waste, the system will automatically switch over to use the
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Hazardous Waste to prevent further overflow. The user is advised to verify that the waste tubing is
draining properly and/or empty the waste container(s).
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End of Run
The system will highlight the slides that have successfully completed staining in light green and mark as “Finished”.
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Figure 49

After completing the final step of the run, the system will prime both pumps to clean the syringes, unlock the door
and prompt the user: “Run Successfully Ended”. The slide chambers are filled with wash buffer during the last step
of the staining protocol to prevent the slides from drying out before they are unloaded from the system.

However, if an error or warning was encountered during the run, the system will instead prompt the user: “Run
Ended with Warnings”.

Finished Notification

Run Ended with Warnings

Figure 50

The user can review the slide map and report data to identify the slide(s) which may have been affected by the
error. Refer to Section 6: Reports, p. 93, for more information.

Do not close any Ul applications or shut down the instrument before the seeing the Finished
Notification message. The instrument may still be in operation.
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Aborting a Run
If the system encounters an irrecoverable error, it will immediately abort the staining process.

The aborted slides will be highlighted in orange or yellow and the system will prompt the user: “Run Aborted Due
to Script Error”. The staining run progress cannot be recovered upon system abort.

Contact Technical Support immediately to verify that the system abort is not caused by a serious
issue on the instrument.
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Figure 51

Note: In an emergency case, the user may manually abort the staining process.
Click “Exit” to close the main interface or power off the system to immediately stop the instrument.
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4.12. Continuous Loading

The Continuous Loading feature allows users to load more slides after the staining process has already started.
Note: Using this feature may significantly increase the total run time and delay the finish time for all remaining
slides in the run. This feature should not be used for time sensitive reagents such as Fluorescence In-situ

Hybridization (FISH). Please call Technical Support for further assistance.

Stop the Current Run

To stop the current run, click “Load New Slides”. The system will stop the progress of each slide as it reaches a
safe stopping point in its staining protocol. The wait times will vary for each circumstance.

ONCORE Pro X System Software
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After the system has stopped the progress of all slides, the door will unlock and a popup message will alert the
user “Run Successfully Stopped”. The slides that have been stopped will be highlighted in light coral and marked

“« ”
Stopped”.
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A Never exit the Main screen after the run has been stopped. The progress on all stopped slides will
be deleted and cannot be recovered.
Restart the Run
Prepare and load new slides. The system will automatically lift the lids of all available slide positions, including
empty positions and positions marked as “Finished”. The positions marked as “Stopped” will be set at the lid Down
position and those slides cannot be unloaded from the instrument.

A Unload all Finished slides before loading any additional slides.

Scan the new slides to automatically assign the protocols, or manually assign new protocols to the available slide
positions. The positions marked as “Stopped” are locked and cannot be assigned a new protocol.
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Load any additional reagents that may be required by the new slides and re-scan the reagent rack.
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Re-start the staining process. The system will reschedule the run to incorporate the new slides. The new slides will
take priority and will run separately until they catch up with the Stopped slides. The Stopped slides will resume
progress when the new slides have reached the same point as the Stopped slides.
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Continuous loading can be repeated on successive steps in the new run schedule; however, the overall runtime for
the Stopped slides will increase with each load of slides.

4.13. Shutting Down the Slide Stainer

From the Main screen, double click “Exit” to close the program. Click “Yes” to confirm.

Exit

Are you sure you want to exit?

Figure 57

This process may take a few minutes as the system waits for all module lids to go the extract position and for all
sub-applications to close. Wait for the application to close completely and return to the login screen before
powering off the instrument

Push and hold the power button on the lower right side of the instrument to power down.
Wait a few minutes after powering down to ensure the instrument powers down completely.

(Optional) Turn off the power supply switch on the back of the instrument.

Shut down the computer from the Start Menu.

A Do not set the module lids to the down position for any extended period of time. Modules should
rest in the extract position when idle.
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Before shutting down the Slide Stainer for an extended period of time (i.e.: long weekends, holidays, transport),
prime the pumps and tubing lines with distilled water to prevent excess buildup of salt. Clean the modules with a
moist paper towel to remove any residual buffer that may dry along the hinge slot and slip holder.
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Section 5. System Utilities

From the Main screen, click “System Utilities” to access additional utility functions and advanced features.
Some features may be restricted depending on user’s security access level. Refer to Security, p. 83, for more
information.

5.1. Tools

Perform manual operations with the system using the functions found under the “Tools” tab.
*Note: Depending on the configuration of the system, some of these functions may not be available to all users.

System Utilities 1 Bak|ng Sl|des
Foi] Edions S < —rTT 2. Load Slide Map File
i Tools i Editors Security Settings Networ . .
e 3. SP1-Z1 Calibration
Baking Slides Initialize System 4., SP1-Z2 Calibration
5. Barcode Calibration
Load Slide Map File Check Modules 6. Tubing Clean
) 7. *(Option) Tubing Clean Log
SP1-Z1 Calibration Prime Z1 and 22 .
8. Move Arm to Middle
SP1-Z2 Calibration Prime Pump Z1 9. *(Option) Module Chamber TraCking
10. Generate Reports
Barcode Calibration Prime Pump Z2 11. Initialize SyStem
12. Check Modules
Tubing Clean Lock Door 13. Prime Pump Z1 and 72
Tubing Clean Log Unlock Door 1? Er!me Eump ;;
. Prime Pump
Move Am to Middle Backup Report Data 16. Lock Door
17. Unlock Door
Module Chamber Tracking Replace Pump 1 Syringe 18. Backup Report Data
. . 19. Replace Pump 1 Syringe
sl ST RS 20. Replace Pump 2 Syringe

Figure 58

Prepare Slides with Baking Slides Function
Click “Baking Slides” to select slides for baking. Check the boxes to select an entire row or select individual slides
by module position. Refer to Baking Slide Settings, p. 84, for more information.

Baking Slides

M1 M2 M3 F4 M5 M6 M7 M8 M9 011412 B1-12
OuBsOuWOBsOwOw70O1BO19 0200102023024 013-24

Ozs02027M28029030M31032433034 K303 [ 25-36

Timer | (0:10:00 Start Stop Retum

Figure 59
Click “Start” to begin baking. The timer on the left will begin counting down and automatically shut heaters off
once the timer reaches 0:00:00.

Click “Stop” to manually stop baking.

Refer to Baking Slides Settings, p. 84, to set up slides for automatic baking before every run.
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Load a Saved Slide Map File

Click “Load Slide Map File” to load and view a previously run slide map on the Main screen. The system
automatically saves the slide map file for each set of slides run on the instrument.

Figure 60

Verify the Calibration of SP1-Z1 or SP1-22
Click “SP1-Z1 Calibration” to move the Z1 probe to module #1 and verify the XYZ position of the Z1 probe.
Click “SP1-Z2 Calibration” to move the Z2 probe to module #1 and verify the XY-Z position of the Z2 probe.
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Figure 61

Verify the Calibration of the Barcode Reader
Click “Barcode Calibration” to move the Barcode Reader to module #1 and verify the XY position of the barcode

reader.
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Clean Z1/Z2 Tubing
Click “Tubing Clean” to open the tubing cleaning feature.
Use the Tubing Cleaning Kit or fill two 15mL vials with an appropriate cleaning solution.

Tubing Clean Place Z2 cleaning solution in reagent rack position #5.
» - Attention Recommendations: Use Slide Brite to remove wax
c,:‘;_, Clezazna Ifthe RFID antenna is attached to Z2 residues in the 72 tubing'
a special reagent rack is needed to
perform this task.
Please place the 21 cleaner on rack Place Z1 cleaning solution in reagent rack position #1.
position .
Recommendations: Use 1% Bleach to remove
Please place the Z2 cleaner on rack X L . .
FniE Hematoxylin/DAB precipitate in the Z1 tubing.
Press "Ok" to continue, or "Cancel” to
stop this task
0K Cancel

Figure 62
Close the door and click “OK” to initiate the tubing clean process.

The Z1 and Z2 probes will both aspirate 5mL of cleaning solution into the tubing from their respective reagent rack
positions. The system will then initiate a 20 minute countdown.

Tubing Clean Counting Down

Tubing clean will be finished at

2/1/2022 5:14 PM

Time Left 0:23:03

Cancel

Figure 63

After 20 minutes has elapsed, the system will automatically perform a System Initialization and purge the cleaning
solution waste.

Click “Cancel” at any moment to immediately purge the waste from the tubing.
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(Optional) Access the Tubing Clean Log

If Tubing Clean Tracking is enabled, the system tracks the number of slides processed since the last tubing clean.
If the total number of slides run exceeds the set threshold, the system will block the user from initiating a new
staining process. Refer to Tubing Clean Tracking Option, p. 88, for more information.

Click “Tubing Clean Log” to review the tubing cleaning status.
Perform a tubing clean to reset the counter or click “Reset” to manually set the counter to 0.

Tubing Clean Log

Tubing Clean Counters

Slides since lastclean:
Total Runs: 10 Reset |

Purge Tubing Cleaning Records

Dated Before Tuesday . February 71,2022 D'| Remove

Remave All

Show Tubing Clean Records Return

Figure 64

Click “Show Tubing Clean Records” to review the entire log of tubing cleans performed to date.
Click “Remove” to clear all cleaning records before the set Date Before.
(Alternative option) Click “Remove All” to clear all tubing records-to-date.

85 Tubing Clean Log Records - =} X

1 of 272 b M » & B A W | 100% -

Tubing Clean Log
1/24/2022 7:08:39 PM

Data Time User Name Shides Since Last Clean Total Runs Clean
149 7 Yes

144 4 No

144 4 No

Figure 65

(Optional) Reset the Module/Chamber Usage Counter

If Module Chamber Tracking is enabled, the system tracks the number of slides processed on each module.

If the total number of slides run exceeds the set threshold, the system will display a red warning message to notify
the user that it is time to replace the chamber. Refer to Module Tracking Option, p. 89, for more information.

ol Reset Module And Chamber Counters — ] b

SelectModules:

M1 M2 M3 M4 A5 H6 M7 M8 M9 HA 1011112 [ 1-12
(113 &1 14 15 [ 16 4 17 [ 18 1 19 1 20 [ 21 [ 22 ] 23 ] 24 1 13-24

[ 25 [ 26 [4] 27 [V] 28 4 29 [4] 30 [4] 31 1] 32 4 33 [ 34 [£] 35 1] 36 1 25-36

Total Number Of Stained Slides

140 Reset Return

Figure 66

Click “Reset” to reset the counter for selected modules back to 0 after replacing the chambers.
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Generate Reports
Click “Generate Reports” to open the Report Generator utility.
Refer to Section 6: Reports, p. 93, for more information.

Move Robot XYZZ Arm to Middle

Close the door and click “Move Arm to Middle” to move the robotic arm to the center of the instrument.

This will enable the user to gain access to the left side of the instrument to fill the buffer bottle and inspect wash
stations, pumps (if applicable) etc.

Perform System Initialization
Close the door and click “Initialize System” to initiate system initialization. The robot will initialize the XYZZ axes
while all 36 module lids move up to Home. Then each pump will initialize over its respective waste station.

Check for Module Malfunction

Click “Check Modules” to check the function of the modules.

The Check Modules window will open to display 36 module checkboxes.

Select the modules using the check boxes then select an option to perform the check:

Check Modules

Select modules:

M1 H2 A3 H4 A5 A6 A7 H8 A9 A0 11 412 M1-12
OBOMEBOBAITHAIBHA9O020A21 A22 023024 013-24
0252627128 12930131 13233134 []35[]36 []25-36

Select check item:
O Heater @® Motion and Heater O Motion

Start Return

Figure 67

Click “Start” to initialize the system and start the countdown timer.

The modules will heat up to a high temperature >100C.
Take precaution not to touch the modules until the heater check has completed and the modules have
cooled down.

Click “Cancel” to cancel the module check at any time.

Check Modules

Finish Time:

2/1/2022 5:12 PM

Remaining Time: 0:1 6:38

Cancel

Figure 68
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1)

2)

3)

Select the Heater option to check for heater malfunction only.

The system will preheat the heaters to 40C, then heat to 103C and verify the temperatures.

The system will highlight any malfunctioning heater in red on the slide map and mark “Low Temperature” or
“Overheating”; otherwise, the system will return the message: “All heaters are functioning properly.”

A The heaters will take several minutes to heat to higher temperatures during the heater check. To
avoid burns/injury, do not resume operation until the heaters have cooled down sufficiently.

Select the Motion option to check for module motion malfunction only.

The system will move the lids to verify all module agitation heights: Home, Extract, Inject and A1-A7.

The system will highlight any malfunctioning module in red on the slide map and mark “Module Malfunction”;
otherwise, the system will return the message: “All modules are functioning properly.”

Select the Motion and Heater option to check for both module motion and heater malfunction.
The system will perform both the heater check and the motion check on the selected modules.

Figure 69

A Protocols may not be assigned to a slide position with a malfunctioning heater or module until the
module is replaced or repaired, and a new module check is performed to clear the error.
Contact Customer Service to repair/replace any malfunctioning heaters or modules.
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Flush Tubing with Prime Pump Z1 and Z2 Function
To flush out the tubing, connect a bottle of distilled water. To clear the tubing lines, connect an empty bottle.
Click “Prime Z1 and Z2” to prime each pump 5x over the waste station.

Prime Pump Z1 or Pump 722
Pump 1 is connected to the Z1 tubing line. Click “Prime Pump Z1” to check the function of Pump 1.
The Z1 probe will move to the wash station and dispense one full draw of buffer.

Pump 2 is connected to the Z2 tubing line. Click “Prime Pump Z2” to check the function of Pump 2.
The Z2 probe will move to the wash station and dispense one full draw of buffer.

Lock or Unlock Door
Click “Lock Door” to manually lock the door.
Click “Unlock Door” to manually unlock the door.

Backup Report Data
Click “Backup Report Data” to make a backup copy of the report data.
Refer to Section 6: Reports, p.93, for more information.

Replace Pump 1 Syringe or Pump 2 Syringe (Distributor Access only)
To prevent leaks/water damage, prime the pump several times using “Prime Z1 and Z2” to clear the fluid in the

tubing line before removing the syringe. Dry the syringe and port valve opening before installing the new syringe.

Click “Replace Pump 1 Syringe” to move the plunger into position before removing the pump 1 syringe.
Click “Replace Pump 2 Syringe” to move the plunger into position before removing the pump 2 syringe.
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5.2. Editors

Access the protocol, reagent, and RFID editors under the “Editors” tab.

System Utilities
Tools Editors Security Seftings Network LIM
Protocol Editor Reagent Editor
Protocol Editor Config RFID Editor
Protocol Reagent Manager Custom Group Editor
Negative Control Editor Panel Editor
Figure 70

Editing Protocols in the Protocol Editor: Overview
Click “Protocol Editor” to open the Protocol Editor window.

The system is pre-installed with a set of protocols optimized to run on the instrument; however, the Protocol
Editor provides several modes of customization to fine-tune the protocols to accommodate the individual tissue
and staining requirements of each lab:
a. Adjust key protocol customizations
Change protocol templates
Add new protocols
Create and modify special protocols (Distributor Access only)
Create and modify protocol templates (Distributor Access only)

®aon o

Pratacol Editor

MsHRP RbHRP MsAP RbAP Multiplex1 Multiplex2 IHC Frozens IHC Extras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExras PathoFISH CytoFISH HemeFISH Special Template

Figure 71

Protocols are grouped under separate tabs for each detection system type, i.e.: HRP, AP, ISH, FISH.
Note: The available detection system types may vary based on the system configuration.
Every protocol (except those listed under Special and Template) is assigned a protocol template.

Protocol Templates are grouped under the Templates tab.
The protocol template is used as the base to generate all protocol parameters, excluding the primary reagent and

the saved protocol customizations.

Special protocols are grouped under the Special tab.
Special protocols are stand-alone protocols that are not generated from a protocol template.
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Click “Version” to display the manufacturer’s protocol version control number (if applicable).
The version control number may be updated each time the manufacturer releases a new set of default protocols
and reagents. Note: User-added protocols do not affect the version control number.

Confirmation X

V2015.12.17
Updated December 17, 2015

+ 10/16/2017 - <V2015.12.17>
+ 10/17/2017 - <V2015.12.17>
+ 10/19/2017 - <V2015.12.17>
+ 11/1/2017 - <V2015.12.17>
+ 7/12/2018 - <V2015.12.17>
+ 7/30/2018 - <V2015.12.17>
+1/18/2022 - <>

Figure 72

Click “Protocol List” in the main window to display the complete list of all protocols, including negative control
protocols, special protocols, and templates.

Note: Click “Save” to export the list to an external text file.

Protocol List

IHC Extras Temp1 A
Ms AP Temp1

Ms HRP Temp1

IHC Frozens Temp1

Multiplex 1 Temp1

CISHDNA 3 Temp1

CISHRNA Temp1

PathoFISH Temp1

CytoFISH Temp1

HemeFISH Temp1

Rb AP Temp1

Rb HRP Temp1

Multinlex ? Temn1 v

Save Return

Figure 73
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Adjusting Protocol Customizations: IHC
Select the appropriate tab in the Protocol Editor to access all protocols grouped under that detection system type.

Protocol Editor
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Select a protocol by clicking the empty cell in the left column of the editor. The selection will highlight in blue.

To display the full protocol, click “Edit” to open the Advanced Protocol Editor.
Note: The user cannot edit the protocol directly from this window because the protocol is generated from a
template.

Advanced Protocol Editor

€D20 CD20 Ms HRP Temp1 Ms HRP Template 1V3/130ul 20181022 end 220ulAd

Max
Do Set Bt Lk Gow Resgent Tpe  ReagertNome e obdon  pcpaonTme | oSO TempemIT  pguin Wash Buffer Type  Wash Buffer # ™ EotMask
e m = 5 v | 000000000430 65C v o
‘ s Iject 00.00:01

» [ A | O O |pewax Iom 20 |Nomal oaoso0 || S04 0EED0 B2 AL000059 |Buffer System Fusd 08 ]
| ; Flo T<NT
| | 003000-00590055C |

v v v v | 00:00:00 - 00:02:30 58°C Inject 00:00:01 v at
2 A5 2 |O|s |onen DS Busfer 20 | Nomal 000430 00.0230-00.08:0055°C A4000059  |Bufler Busfer 120 0
‘ 00:0800-0053:00 37°C TNt
‘ s & v v 3001500 v v
‘ . 00:00:00- 0027:00 101C
3 5] B (O |Retieval ARZ.low pH 0 |Nomal 003200 e MBT0 o System Fusid 1|20 0
v | = v =5 I | inject 00:00:01 S 155
e [ @ |Oe |oder System Plad 20 |Nomal 000420 || 000000-00590033C AL000059  |Bufer System Fuud 0|85 0
}  — ! I T<NC
[ [v = v v Inject 00:00:01 v v
5 [c| @ Olw  |sboycc ooz 10 |Nomal 003000 00:00:00-00:30:0025°C KOO e System Flud 120 0
<
Figure 75

Most parameters displayed in the Advanced Protocol Editor are determined by the protocol template; however,
the user has the option to make further customization by changing the protocol template or creating a special
protocol. Refer to “Creating and Modifying Protocol Templates”, p. 65, and “Creating and Modifying Special
Protocols”, p. 64, for more information.
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The user may adjust the key protocol parameters directly in the main window: pretreatment, antigen retrieval,
peroxidase blocking and antibody incubation.

DS Buffer Option AR Option ;I'(e:r}np Block Option ~ Reagent Name L'g‘ui Min ‘Témp
DS2-50 v | AR1, high pH v 101 |Buffer v | Bcl-6 0 30 25
DS Buffer v | AR1, high pH v 1101 |Buffer v |CD138 0 30 25
DS2-50 v | AR1, high pH v 1103  |Buffer v |CD15 0 59 25
AR2, low pH v 1101 |Buffer v |CD20 0 30 25
AR2, low pH v |90 Block v |CD21 0 30 25
AR1, high pH v |85 Block v |CD23 0 30 25

Figure 76

To customize the pretreatment reagent, select from the dropdown list under DS Buffer Option.

A.
B.

C.

DS2-50. This is the default option. Dewax solution 2 is applied to enhance antigen retrieval.

DS Buffer. Select this option to apply wash buffer instead of Dewax solution 2. This option may improve
morphology or improve over-staining by reducing the strength of antigen retrieval.

DSE-50. Select this option to apply a protease enzyme, incubated at 58C, instead of Dewax Solution 2.

To customize the antigen retrieval reagent, select from the dropdown list under AR Option.

A.
B.

C.

AR1. This is the default option. Antigen Retrieval solution 1, high pH 9 is applied.

AR2. Select this option to apply Antigen Retrieval solution 2, low pH 6. This may improve morphology or
improve over-staining by reducing the strength of antigen retrieval.

AR Buffer. Select this option to apply wash buffer instead of Antigen Retrieval solution. This option may be
used when antigen retrieval is not required. Note: Set incubation temperature to 37C to reduce evaporation.
AR Enzyme. Select this option to apply a custom enzyme instead of Antigen Retrieval solution.

Note: Set incubation temperature to 37C. Requires 370ul/test fill volume.

Note: It is recommended to create an alternate protocol template or special protocol because the high volume
may cause some overflow.

To customize the antigen retrieval incubation temperature, adjust the Temp ( C).

A.

B
C.
D

101C is the default temperature for antigen retrieval.

Reduce the temperature to 98C /95C (or lower) to reduce the strength of antigen retrieval.
Increase the temperature to 103C or higher to increase the strength of antigen retrieval.
Reduce the temperature to 37C if an enzyme or buffer option was selected.

To customize the peroxidase blocking reagent, select from the dropdown list under Block Option.

A.

B.

Buffer. This is the default option (no blocking step). AR1 is formulated to provide sufficient blocking under
most conditions.
Block. Select this option to apply H20:2 block instead of wash buffer.

To customize the primary antibody incubation time and temperature, adjust the Time (hh,mm,ss) and Temp ( C).

A

B.
C.
D

25C is the default temperature for antibody incubation.

Increase the incubation temperature to 37C to increase staining intensity.

Decrease the incubation time (minimum 10min) to decrease the staining intensity.

Increase the incubation time to 45min/1hr to increase staining intensity.

Note: Increasing the incubation time (or temperature) may affect the staining area by increasing evaporation.
It is recommended to adjust the antibody dilution to maintain an incubation time <30min.
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Click “Save” to apply and save the changes to the selected protocol(s).
All protocols that have been modified from the manufacturer’s default protocol will be “Marked as Changed”.

A The user may backup these protocol customizations under System Utilities>Settings> “Save All
Customizations”. Refer to p. 87, Save All Customizations, for more details.

Protocol Editor

MsHRP RbHRP MsAP RbAP Multiplex1 Multiplex2 IHC Frozens IHCExtras CISHRNA CISHDNA1

CISHDNA2 CISHDNA3

CISHExras PathoFISH CyloFISH HemeFISH Special Template

tk o8, index ProtocolNome ~ Descrpton DS Buffer Opton AR Opton Te™: ok Optin  Reagent Nome Lo [ a
O |8 [ss Ms HRP Template 1V3/130u 20181022 end 22... |DS2:50 ~[AR1. highpH o [adter  v|Bas REIES
O |# |cous Ms HRP Template 1V3/130ul 20181022 end 22... DS Buffer < |AR1.bigh pH v[101 |asler  |v|cDt38 0 % |
O | |cots Ms HRP Template 1V3/130u 20181022 end 22... |D5250 | AR1. high pH Cl103 |Bfler  v|cO15 0 | |
@ |7 o Ms HRP Template 1V3/130u 20181022 end 22... DS Bulfer | AR2.low pH v|101 |afler  |v|cO20 0 (% |
0O [& |cozn Ms HRP Template 1V3/130u 20181022end 22... [DS250 < |AR2.low pH vl [mock  |v|cozr 0o % |
O |» |co Ms HRP Template 1 V3/130u 20181022end 2... [D5250 | AR1,highpH v|ss |Bock v|cD23 0 |0 |
O |6 |cou Ms HRP Template 1V3/130ul 20181022end 22... |D5250 | AR, high pH Cl101 |Bfler  |v|cDM 0 % |

O |t |cose Ms HRP Template 1V3/1304 20181022 end 22... |DS Buffer | AR, high pH |101 |Bfler v CDS6 0 |45 |5
O | |co7 Ms HRP Template 1V3/1304 20181022 end 22... [DS2:50  |AR1, high pH Cl1o1 [mock  |v|co7 (REE
O | |cox Ms HRP Template 1V3/130u 20181022 end 22... |DS2:50 | AR1. high pH vl101 [Bfler  |v|cOX2 0 |0 |
O |5 |cks Ms HRP Template 1 V3/130u 20181022 end 22... |DS250 | ARZ.low pH “loo Bk v|ckis 0 |w |»
O |7 |cko Ms HRP Template 1V3/130u 20181022 end 22 |DS250 | AR low pH 10 Bl v|ck20 0 (% |
O | | Ms HRP Template 1V3/130u 20181022¢end 22.. |DS250 | AR1. highpH vl101 |pster  |v|ckr 0 |0 |5
O | |cata3 Ms HRP Template 1 V3/130u 20181022 end 22... |DS250 | ARZ.low pH [0 [mock  |v|GATA3 0 % |
O |65 |Mammagobn Ms HRP Template 1V3/130u 20181022end 22... |D5250 | ARZ.low pH Clss  [Bufer || Mammagobn (RENE
O s |mwsw2 Ms HRP Template 1V3/130u 20181022 end 22... |DS2:50  [AR1. high pH v[101 |aster v |msH2 L
O |»  |msks Ms HRP Template 1V3/130u 20181022 end 22... |DS2:50 | AR1, high pH 101 |Bafer | v|MsHE 0 |5 |37
0O |5 |o& Ms HRP Tempiate 1V3/130u 20181022 end 22... |DS250 + |AR1. highpH Vot Bl voe3 0% | v

— 1~ I == = =

Click “Cancel” to cancel all unsaved changes.
Click “Return” to exit the Protocol Editor.

Adjusting Protocol Customizations: ISH/CISH/FISH

Figure 77

Select the appropriate protocol tab in the Protocol Editor to access ISH, CISH, or FISH protocols.

Protocol Editor
MsHRP RbHRP MsAP RbAP Muliplex1 Multiplex2 IHC Frozens IHC Extras [CISHRNA| CISHDNA1 CISHDNA2 CISHDNA3 CISHExtas PathoFISH CytoFISH HemeFISH Special Template
GH:;d Index  Protocol Name ~  Description Reagent Name l’: Mo (O
» (m} 101 EBER Probe CISH RNA Template 1V3/130ul 20181022 end ISHzyme 0 10 25
O 103 | Kappa Probe CISH RNA Template 1V3/130ul 20181022 end ... |ISHzyme [] 10 25
O 105 | Lambda Probe CISH RNA Template 1V3/130ul 20181022 end ... |ISHzyme 0 10 25
(m} 107 RNA- Probe CISH RNA Template 1V3/130ul 20181022 end ISHzyme 0 10 25
(] | CISH RNA Template 1V3/130ul 20181022 end .. 0 25

Bl By 1 1 1 2 IR

Figure 78

To customize the enzyme incubation time and temperature, adjust the Time (hh,mm,ss) and Temp (' C).
Click “Save” to apply and save the changes to the selected protocol(s).

The user may backup these protocol customizations under System Utilities>Settings> “Save All
Customizations”. Refer to p. 87, Save All Customizations, for more details.
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Refreshing Protocol Customizations
The user may save and restore the protocol customizations after making a change in the Protocol Editor.

Backup the protocol customizations before refreshing the protocols, if necessary. Any recent
customizations that have not been backed up using “Save all Customizations” will be overwritten during
the refresh process. Refer to Save All Customizations, p. 87, for more details.

Click “Protocol Editor” to open the Protocol Editor window.
Select the protocol (s) by clicking the empty cell in the left column of the editor. The selection will highlight in blue.

Click “Refresh” and select the desired refresh option, then click “OK”".

A. “Refresh with saved customization” will restore the protocol(s) using the user’s saved customizations.

MsHRP RbHRP MsAP RbAP Multplex1 Muliiplex2 IHCFrozens IHCExtras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExtras PathoFISH CyloFISH HemeFISH Special Template
Mark as index  Protocol Name . . . Temp. 8 Time Temp. A
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0O |3 o5 Ms HRP Template 1V3/130u 20181022 end 2. |DS2-50 ~ | AR1. high pH ~[103 | Buffer v |co1s REIE
» = 7 Ms HRP T 1V3/130u 20 d22.. [N ~ | ARZ. low pH ~ Buffer ~
0O |& con Ms HRP Template 1V3/130u 20181022end 22 |DS2.50 | AR low oH |50 |Block v |coz EEIRES
O ¥ D2 Ms HRP Template 1V3/130u 20181 Refresh Protocol Options IT~] 85 Block w|cD23 0 n |5
O |5 |com Ms HRP Template 1V3/130 20181 ) o [ <] 101 [oufer ~|cpu4 REE
0 .51 D56 ‘M:HRP Template 1 V3/130d 2018/ @ Refresh with saved customization '—v 101 |Baier < |cose 0 " '25
O [s3 co7 Ms HRP Template 1V3/130ul 20181 () Refresh with manufacturer default 721101 |Bock “lcor 0 0 |5
O [er |coxe Ms HRP Template 1V3/1304 20181 | [~ [ourer  [~|coxe o w |
O |5 |cks Ms HRP Template 1V3/1304 2018 Cancel oK : %0 [Bock |v|cK19 [EIE
0O |s7 |cka Ms HRP Template 1V3/130u 20181 ~[101 | Buffer ~ |cK20 I
O l5‘3 CK7 ‘M:HRPT:WM:IVNIWZ)WWZZMZZ. |DS250 ~ | AR1. high pH ~[101 | Buffer ~ |CK7 0 30 l25
O 63 GATA3 Ms HRP Template 1V3/130ul 20181022 end 22... |DS2-50 ~ | AR2. low pH ~[101  |Block ~ |GATA-3 0 30 2
[0 (65  Mammaglobn Ms HRP Template 1V3/130u 20181022 end 22.. |DS2-50 ~ | ARZ. low pH v |35  |Bufer v | Mammagiobin I
O [e3 | msw2 Ms HRP Template 1V3/130u 20181022 end 22... |DS2-50 ~ | AR1. high pH ~[101 | Buffer ~ | MsH2 EED
O 73 MSHE Ms HRP Template 1V3/130ul 20181022 end 22... |DS2-50 | AR1. high pH ~[101 | Buffer ~ | MSHE 0 45 7
0 5 &3 | Ms HRP Template 1V3/130ul 20161022 end 22 | DS2:50 ~ | AR1, high pH ~[101 | Buffer v |p63 I NES v
| Save Edit Add Delete Change Template Refresh All Protocols Protocol List Version Cancel Return
|
Figure 79

B. “Refresh with manufacturer default” will reset the protocol(s) to the manufacturer’s customizations.

MsHRP RbHRP MsAP RbAP Multiplex1 Muliiplex2 IHC Frozens IHCExtras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExras PathoFISH CytoFISH HemeFISH Special Template

Sl <|«<

Refresh Protocol Options

O Refresh with saved customization
® Refresh with manufaturer default

£

L

Figure 80
Tip: Select multiple protocols by holding down the Ctrl key. Select all protocols in the tab by clicking the cell in the
upper-left corner.
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Changing the Assigned Protocol Template
Some staining protocols may require further customization beyond the available parameters accessible in the main
Protocol Editor window. In such circumstances, the user may assign a different protocol template.

AContact Technical Support for assistance. Only users with Distributor access may create or modify
protocol templates. Refer to “Creating and Modifying Protocol Templates”, p. 64, for more information.

Click “Protocol Editor” to open the Protocol Editor window.
Select the protocol by clicking the empty cell in the left column of the editor. The selection will highlight in blue.

To select a different protocol template, click “Change Template”.
The Select Template window will open and display the Protocol Templates available for this Protocol Type.
The current assigned protocol template is highlighted in blue.

ANote: Make sure to save all current protocol customizations in Settings before proceeding. The
protocols must be regenerated after changing the protocol template. Any unsaved customizations will
be overwritten.
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O |57 |ckeo Ms HRP Template 1 V3 | [ostler  |~|ck0 0 |30 |
O | | Ms HRP Template 1V3 [ [ | oo 0 (% |
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Save Edit Add Delete Refresh Protocol List Version Cancel Return
Figure 81

Select the desired protocol template and click “OK” to change the template assighnment. The system will
automatically regenerate the protocol using the selected template and apply the saved protocol customizations.

Protocol Editor
MsHRP RbHRP MsAP RbAP Multiplex 1 Multiplex2 IHC Frozens IHC Extras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExtras PathoFISH CytoFISH HemeFISH Special Template
23, ldex Protocol Name Deserption DS Buffer Option AR Option TE™: Biock Option  Reagent Name T | e, | foe -
O |a |es Ma HRP Template 1V3/130u 20181022 end 22... | 5260 < [AR1. hgh pH Clion [Bier |v|Bds ERE
0O & |cons Ms HRP Template 1 V3/130ul 20181022 end 22 | DS Buffer < |AR1. high pH “l101 |Bte v |cD138 0 |1 |25
O B cD1s Ms HRP Template 1 V3/130ul 20181022 end 22... |DS2:50 ~ | AR1, high pH ~ 103 Buffer ~ |CD1S 0 89 25
» = Ms HRP Template 2 V3/130ul 20181022 end 22... UER:T. 04 ~ |AR2, low pH g 101 Buffer B C020 0 0 25

Figure 82
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Adding New Protocols in the Protocol Editor
The user may create new protocols to test third-party antibody products, different antibody titers, and various
customization options to aid in staining optimization.

To add a new protocol, select the appropriate protocol tab of the Protocol Editor, and click “Add”.
Input a unique name in the field for Protocol Name.

Each protocol must have a unique name. Append a short suffix to the end of the protocol name to
distinguish the detection system used or modifications made.

To avoid conflicts with positive or negative controls in the programming software, please refrain from
using the symbols “+” and “-“at the end of the protocol name.

MsHRP RbHRP MsAP RbAP Multiplex1 Muliiplex2 IHC Frozens IHC Extras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExtras PathoFISH CytoFISH HemeFISH Special Template
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O 68 |WsH2 Ms HRP Template 1 V3/130ul 20181022 end 22... | DS2-50 | AR1. high pH v 101 |Buffer v |MSH2 0 |45 |37
O 3 MSHE Ms HRP Template 1 V3/130ul 20181022 end 22 DS250 ~ | AR1, high pH ~ 101 Buffer w | MSHE 0 45 7
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Figure 83

Select the Reagent Type and Reagent Name of the primary reagent.
Refer to “Adding New Reagents in the Reagent Editor”, p. 75, for more information on adding new reagents.

Select the Template Name, if more than one template is available.
Refer to “Creating and Modifying Protocol Templates”, p. 64, for more information on adding new templates.

Click “Add” to generate a new protocol from the selected protocol template.

Note: New protocol(s) will be generated with default customizations based on the protocol template.

The user must customize the new protocol(s) based on the desired test parameters, vendor’s datasheet, or
manufacturer’s recommendations.

Click “Return” to close the window after all protocols are added.

To delete a protocol, select the protocol from the left-most column and click “Delete”.
Note: The system may restrict the user from deleting certain protocols created by the manufacturer.
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Creating and Modifying Special Protocols (Distributor Access only)

Special protocols are grouped under the Special tab of the Protocol Editor. These stand-alone protocols offer users
the flexibility to customize each step of the staining protocol to fulfill the special requirements of new staining

applications, ie: Special Stains, IF, Multiplex etc.

Only users with Distributor access may create special protocols. Contact Technical Support for

assistance. New protocols may be imported to the system using the Protocols and Reagents Manager.
Refer to p. 72, Importing Protocols in the PR Manager.

Select the Special tab in the Protocol Editor to view the list of special protocols.

Protacol Editor

m Index  Protocol Name . Description
[0 |20 |CeanChamber Clean minor DAB residues (mod for 130u chambe
» 0 17 |Cycin D1 Rb Special | 2TR1 103¢ 30mRb HRP 53m3%c
a 18 Extracting Test 130ul chamber: 200Ul A4 2 Add Protocol
(] 19 Special TR 53m37c
135 |PINg P4D-HMW(HRP), APp504{ Protocol Name

new special protocol

MsHRP RbHRP MsAP RbAP Muliiplex1 Multiplex2 IHC Frozens IHCExtras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExwras PathoFISH CytoFISH HemeFISH Special Template

Save Edit Add Delete Change Template Refresh Refresh All Protocols H Protocol List H Version ‘ Cancel Return

To add a new special protocol, click “Add”.

R Figure 84

Enter the Protocol Name and click “Add” to generate a basic one-step protocol.

AThe protocol name must be unique. Refer to the Protocol List to view the full list of protocols.

Advanced Protocol Editor

Max
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Figure 85

The Advanced Protocol Editor will automatically open to display the details of the special protocol.

Insert additional steps and modify the special protocol as needed.

Refer to “Editing Protocol Parameters in the Advanced Protocol Editor”, p. 68, for more information.

Protocol Name stores the name of the protocol.
Protocol Type identifies the protocol as Special.

Primary Reagent is not identified because special protocols are not generated from a template.

Control Reagent is not identified because special protocols are not customizable from the main window.

Description stores the description that will be displayed in the main window.

Open To stores the security access level of the protocol.
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Alternatively, right-click and Copy a protocol, template or special protocol from any tab in the Protocol Editor.
Note: It is recommended to select a similar existing protocol to use as a base for generating the special protocol.

Protocol Editor

MsHRP RbHRP MsAP RbAP Muliplex1 Multiplex2 IHC Frozens IHCExtras CISHRNA CISHDN

Mark as . )
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Figure 86

Right-click and Paste the protocol into the Special tab and enter the Paste Name.

Protocol Editor

MsHRP RbHRP MsAP RbAP Mulliplex1 Muliiplex2 IHC Frozens IHCExtas CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExwas PathoFISH CyloFISH HemeFISH Special Template

XTR1 10 e
130ul chamber: 200ul A4: 240ul quick wash, 130.

TR 59m37c
P40+HMW(HRP), AP-pS04s

Paste Name
Enter Paste Name: new special protocol

Figure 87

To modify a special protocol, select the protocol in the Special tab and click “Edit” to display the details of the
protocol. Note: Users with Distributor access may edit the special protocol directly from this window. Users with
Supervisor access may have limited permissions to edit certain steps only.

To delete a special protocol, select the protocol and click “Delete”. It is recommended to delete special protocols

that are no longer used for system efficiency.
Note: Manufacturer’s protocols may be protected by the system and cannot be removed.
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Creating and Modifying Protocol Templates (Distributor Access only)

Protocol templates are grouped under the Templates tab of the Protocol Editor. Users may create additional
templates to apply additional protocol customization(s) to a subset of protocols grouped under the same detection
type. ie: add protein block step, add enzyme digestion step, customize counterstaining or customize antigen
retrieval time.

Only users with Distributor access may create or modify protocol templates protocols. Contact
Technical Support for assistance. New templates may be imported to the system using the Protocols and
Reagents Manager. Refer to p. 72, Importing Protocols in the PR Manager.

Select the Template tab in the Protocol Editor to view the list of protocol templates.

! Protacol Editor
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Figure 88

To add a new protocol template, click “Add”.
Enter the Template Name and click “Add” to generate a basic one-step protocol template with the Primary
Reagent automatically added.

The protocol template name must be unique and must contain the word, “ Temp”
Note: “Temp” is preceded by a space.

The template’s primary reagent must be set be the same as the protocol template name.
Note: This name is used as a space holder to indicate the position in the template to be replaced by each
protocol’s primary reagent when the template is used to generate protocols.

Advanced Protocol Editor

Ms AP Temp2 vtz B Pueretemz -
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The Advanced Protocol Editor will automatically open to display the protocol template.

Select the appropriate Protocol Type or enter a new type.

Insert additional steps and modify the protocol template as needed.

Refer to “Editing Protocol Parameters in the Advanced Protocol Editor”, p. 68, for more information.

Protocol Name stores the name of the template.

Protocol Type identifies the detection system type assigned to the template.

Primary Reagent identifies the primary reagent (antibody or probe) in the template.

Control Reagent identifies the reagent to be customized for incubation time and temperature in the main window.
Description stores the description that will be displayed in the main window.

Open To stores the security access level of the template.

Alternatively, right-click and Copy a protocol, template or special protocol from any tab in the Protocol Editor.
Note: It is recommended to select a similar existing protocol to use as a base for generating the template.

Right-click and Paste the protocol into the Template tab and enter the Paste Name.

Protocol Editor

MsHRP RbHRP MsAP RbAP Multiplex1 Multiplex2 IHCFrozens IHCExtras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExtras PathoFISH CytoFISH HemeFISH Special Template
Gk 2s,  Index _Protocol Name Descripton
'O 1 [HCEtrs Temp [IHC Extras Template 1V3/130u 20181022 end
»
a |3 Ms HRP Temp1 Ms HRP Template 1V3/130ul 20181022 end 22
O |4 IHC Frozens Temp1 IHC Frozens Template 1
O |s Mutiplex 1 Temp1 Mutiplex 1 Template 1
00 |6  |CISHDNA3Temp! This s afake template forCIS{
| [ CISH RNA Temp1 CISH RNA Template 1V3/13{
8 PathoFISH Temp1 Thisis af: for Py
—D stth la B 8 foes il {7 Pl Enter Paste Name: Ms AP Temp2
7 CytoFISH Temp1 This is a fake template for Cyts
[0 |10 |HemeFISH Temp1 This is afake template for Hen
O [0 A temt Fo A Terite V213042 [ox ]
mn 172 R HRP Tamn1 R HRP Tamnista 112120

To modify a template, select the template in the Template tab and click “Edit” to display the details of the
protocol template. Note: Users with Distributor access may edit the protocol template directly from this window.

A After saving changes to the protocol template, the system will automatically regenerate all assigned
protocols to apply the changes. Note: The user may manually refresh all protocols with their assigned protocol
templates by clicking “Refresh All Protocols” in the Templates tab.

Protocol Editor

MsHRP RbHRP MsAP RbAP Multiplex1 Multiplex2 IHC Frozens IHCExtras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3J CISHExras PathoFISH CytoFISH HemeFISH Special Template

Mark as
Changed 'Mdex  Protocol Name Description

O Ms AP Template 1V3/130ul 20181022 end 220u..

3 ]
O |4 |IHCFrozens Templ IHC Frozens Template 1
O [5 Mplex 1 Temp Muliplex 1 Template 1
O 6 CISH DNA 3 Temp1 This is a fake template for CISH DNA 3 Temolate
O |7 |CISHRNATemp! CISH RNA Template 1 V3130 201 Refresh Protocal Options
O |8 PathoFISH Temp! This is  fake template for PathoFISH -
O |9 cptoFISH Temp1 This is 2 fake template for CytaFISH © Refresh with saved customization
O |10 HemeFISH Temp! Thisis afake template for HemerISH O Refresh with manufaturer default
O (1 RoAPTempt Rb AP Template 1V3/130ul 201810)
O [12 |AoHRP Tempt R HRP Template 1 V3/130 2016 oK
O [13 | Mtplex 2Temp! Muliplex 2 Template 1V3/130d 201 )

Figure 90
To delete a template, select the protocol and click “Delete”. All protocols assigned to the template must be

deleted or assigned to a new template before the template may be deleted.
Note: Manufacturer’s templates may be protected by the system and cannot be removed.
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Editing Protocol Parameters in the Advanced Protocol Editor
Special Protocols and Templates may be modified using the Advanced Protocol Editor.

Advanced Protocol Editor
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Figure 91

Right-click the protocol step(s) or use the tool buttons to add and remove steps:
Select and “Copy” protocol step(s), then “Paste...” at another line in the protocol.
Select and “Cut” protocol step(s), then “Paste...” at another line in the protocol.
Select and “Insert...” a new step at any line in the protocol.

Select and “Delete” a step at any line in the protocol.

Click “Save” to save all changes.

Click “Undo” to revert to the previous saved state.
Click “Return” to close the Advanced Protocol Editor.
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Edit the following parameters, as needed, for each step of the protocol or template.
Refer to the Specialist manual for more details.

Advanced Protocol Editor
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Figure 92

Set. Configure the RunSet pattern to optimize runtime scheduling. Note: It is recommended to set the same
standard RunSet pattern i.e.: AABBC(D variable) across all protocols and protocol templates to ensure that they can
be run together efficiently in the same staining run.

Extract. Select the option to extract the waste from the previous step before dispensing reagent.

Link. Select the option to link two consecutive steps. This will ensure that the current step is immediately executed
upon completion of the previous step, without interruption from other processes running in the same staining run.
Note: Selecting this option may negatively affect overall runtime as it reduces scheduling flexibility.

Max Group Size. Set the maximum group size smaller (default 18) to improve the incubation accuracy of time-
sensitive reagents. The run scheduler will pool common steps between protocols and execute them together.

Groups of 18 slides will have ~4 min longer “effective” incubation time compared to 1 slide, due to the longer

dispensation time for a larger group.

Note: Setting a smaller group size will negatively affect overall runtime by increasing scheduling complexity.

Reagent Type and Reagent Name. Select the reagent.

Volume. Set the reagent volume. The volume drawn from the vial is augmented by a factor of 1.08. The volume
dispensed may vary slightly based on the viscosity level setting.
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Incubation Type:

A. Select Normal incubation. The “effective” incubation time is slightly longer than the set time due to the
reagent dispensation time, which varies based on group size.

B. Select Fine incubation to precisely control the incubation time <1min. The protocol step will be executed
individually for each slide to ensure incubation accuracy (within seconds). System fluid is dispensed at the
end of this process. Note: This option may greatly affect overall runtime when the incubation time is set
>2min.

C. Select AirDry incubation to perform a Fine incubation with drying. No fluid is dispensed at the end of this
process.

D. Select Accurate incubation to precisely control incubation time >1min.-This feature is currently in
development and is not available at this time.

Incubation Time. Set the total incubation time.
Note: Setting long incubations times may reduce the staining area, especially for heated processes.

Incubation Temperature Table. Configure the temperature and corresponding heating time period.
Note: Set the heat incubation longer than the Incubation Time to perform heated washes and to maintain the
temperature until the next Step is executed.

Edit Temperature Table

From To Temperature
1.000000- s

2.00:04:30- |00:59:30
3.00:59:30- |00:00:00
Figure 93
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Agitation. Configure the agitation parameters. The module lids will alternate between two angles, Lid Up Position
and Lid Down Position, at a certain frequency, Lid Up Time and Lid Down Time. This mechanism helps to
accelerate the rate of reaction, improve uniformity, and disperse air bubbles. Additionally, set the Threshold
temperature to stop agitation above a certain temperature set point.

Note: Agitation angles must be set in consideration of the reagent volume. Agitation frequency must be set in
consideration of the incubation time and temperature.

Agitation Parameters
Lid Up Position: Inject v Lid Up Time: l00:00:01 :
Lid Dn Position: A4 v Lid Down Time:  [00:00:59 s
Threshold ("C): 71 -
Cancel OK
Figure 94

Wash Buffer Type and Wash Buffer. Select the quick wash reagent. A quick wash is executed immediately at the
end of incubation and will agitate twice automatically. The default reagent is set to System Fluid (wash buffer).

# and Volume. Select the number and volume of quick washes.

Note: The quick wash ensures that the reagent is promptly removed at the end of the Step without interruption
from other processes running in the same staining run. Include a quick wash or linked wash step to control time-
sensitive incubation steps (within minutes).
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Configuring the Protocol Editor
Click “Protocol Editor Config” to configure the main Protocol Editor window.
This feature may be used when configuring the system for new protocol types.

Protocol Editor configuration

Protocol Types Display Orders

A

Rb HRP

Ms AP

Rb AP f
Multiplex 1

Multiplex 2

IHC Frozens

IHC Extras

CISHRNA

CISHDNA1

CISHDNA 2 ‘
CISHDNA 3 v

Select Editing Options
DS Buffer Option
TR Option
Block Option

Return Save

Figure 95

Adjust the Protocol Types Display Order using the up/down arrows to change the order of the tabs displayed in
the Protocol Editor. The display order can be changed to prioritize frequently used protocol types.
Note: Remove unnecessary Protocol Types by deleting all reagents of that type in the Reagent Editor.

MsHRP RbHRP MsAP RbAP Multiplex1 Multiplex2 IHC Frozens IHC Extras CISHRNA CISHDNA1 CISHDNA2 CISHDNA3 CISHExtras PathoFISH CytoFISH HemeFISH Special Template

Figure 96

Configure Select Editing Options to change the customization options for each tab in the Protocol Editor.
Select the Protocol Type from the list and select the desired options:
DS Buffer Option

AR Option
Block Option
DS Buffer Option AR Option Temp Block Option ~ Reagent Name Time ) Temp.
(C) Hour Min. ()

DS2-50 ~ | AR1, high pH ~ 1101 |Buffer v | Bcl-6 0 30 25

DS Buffer ~ | AR1, high pH ~ 1101 |Buffer v |CD138 0 30 25
DS2-50 ~ | AR1, high pH ~ 1103  |Buffer v |CD15 0 59 25

DS Buffer ~ | AR2, low pH ~ 1101 | Buffer w |CD20 0 30 25

Figure 97

Note: The Control Reagent option is always displayed and is set by the protocol template.
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Importing Protocols in the PR Manager

Export packages are periodically released to the user in order to 1) update protocol templates and protocols, 2)
add additional applications and products, or 3) add special protocols. These packages may be imported into the
system using the PR Manager utility. Contact Technical Support for more information.

Click “Protocol Reagent Manager” to open the Protocol and Reagent Manager utility.
Login with the User ID and Password.
From the Import tab, click “Browse” and select an export package (compressed zip folder).

Note: Do not unzip/extract the export package.

Tip: It is advised to make a backup copy of the data before making upgrades to the SW or protocols.
Please contact Technical Support for assistance.

The new protocol(s)/template(s)/special protocol(s) to be imported are listed under Import Protocols.
The associated reagent(s) to be imported are listed under Import Reagents.
The associated negative control link(s) to be imported are listed under Import Negative Control.

Protocols And Reagents Manager

Export Import

Import File ‘ \PathCom\Exports\Export-2022-01-31 zip J Browse

Import Protocols Import Reagents Import Negative Control

CD20 Antibody C-C ... CD20 ) CD20... Universal Negative
Buffer ... Block
Buffer ... Buffer
Buffer ... System Fluid
Detect... DAB Chromogen
Detection ... DAB
Detection ... DAB Buffer
Detection ... Mouse HRP
Dewax... DS1
Dewax ... DS2-50
Dewax ... DSE-50
Negative ... Universal Negative v

Delete Protocols Delete Reagents

Import Display Current Protocol Version Exit

Figure 98
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Note: The manufacturer may use the export function to remove obsolete protocols and discontinued products.
The protocols to be deleted are listed under Protocols to Delete.
The reagents to be deleted are listed under Reagents to Delete.

Click “Import" to import the contents of the export package. A status bar will be displayed to show the progress of
the import process.

‘@ A After the system has imported a new protocol, the system will automatically refresh all protocols.
Save all customizations before performing an import, otherwise, some recent protocol modifications may be
lost.

All new protocols, templates and reagents will be added to the system.
A All existing protocols or templates that share the same name as an imported protocol will be overwritten.

All existing reagents that share the same name as an imported reagent will be overwritten.

Note: Protocols cannot be transferred between different protocol versions. The protocol import process will abort if
the current protocol version number does not match the version number of the export package. Please update to
the latest protocol version before importing a new protocol package.

Error - - |

.' ~ | The protocols in package
‘N C:\PathCom'\Exports\Export-2015-06-02officialupdate.zip can only be
imported into protocols with base version V.012215. Your protocol base

version is V150602, Protocol import failed!

Figure 99

Click “Display Current Protocol Version” to view the current protocol version number. The version number will
automatically update after importing a manufacturer’s protocol update.

The manufacturer’s protocol updates must be imported in sequential order. The current protocols
must be up-to-date before installing the next manufacturer’s release.

Click “Exit” to close the utility.

Exporting Protocols in the PR Manager (Distributor Access only)

Click “Protocol Reagent Manager” to open the Protocol and Reagent Manager utility.
Login with the User ID and Password.

Click the Export tab to view the export options:

Click “Browse” to designate the From Folder containing the protocol(s) to be exported.
Click “Browse” to designate the destination Export Folder for the export package.

Enter the Export File Name.
Select the protocol(s) to be exported under Available Protocols to Export.

Note: Protocols of different detection types, Templates or Special protocols may be selected using the dropdown list
for Type.
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Protocols And Reagents Manager

Export Import
From Folder: C:\PathCom\PathComASGui\Data | Browse
Export Folder C\PathCom\Exports | Browse
Export File Name Export-2022-01-31.zip Export Type: [] Base Version Update
Export Protocols and Reagents
Type: MsHRP ~ Protocols to Export: Reagents to Export:
CD20 Antibody C-C ... CD20 ~
Available Protocols to Export Buffer .. Block
Bcl-6 A~ Buffer ... Buffer
CD138 Buffer ... System Fluid
CD15 Detect ... DAB Chromogen
CD20 Detection .., DAB
CcD21 Add Detection ... DAB Buffer
cD23 Detection .., Mouse HRP v
CD34
CD56
cD7 )
CDx2 Remove Negative Controls to Export
CK19 v CD20 ... Universal Negative

Protocols to Delete Reagents to Delete Protocol Version Control

Importer's Version

Exporter's Current Version

V2015.12.17
1/31/2022 - modified CD20
Delete Protocol: Type: l:l
[ Name: \—]
Add Remove Add Remove
Export Display Current Protocol Version Reset Exit
Figure 100

Click “Add” and “Remove” to modify the list of Protocols to Export.
The Reagents to Export and Negative Controls to Export are automatically added.

Ensure that the Importer’s Version and Exporter’s Current Version Control numbers match.

Alternately, select the option Base Version Update to change the Importer’s Version Control number upon import
of the package.

Click “Export” to create an export package in the designated destination folder.

'a::,Open x
« v o <« Windows (C:) » PathCom » Exports » v (] Search Exports Lo
Organize v New folder ==+ [A o
¥ Downloads ) Name - Date modified Type Size
b Music { Export-2022-01-31.zip 1/31/2022 6:09 PM Compressed (zipp.. 7
&=/ Pictures
B videos
e Windows (C) v <« =
File name: | Export-2022-01-31.zip ~|  zip Files "zip) v

Figure 101
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Adding New Reagents in the Reagent Editor
The user has the option to add third-party antibody products or other approved reagents to the system.
This may be necessary when certain reagents are not offered in the Oncore Pro product line.

Click “Reagent Editor” to view and manage the system’s reagents.
Note: The reagent list may vary based on the system configuration and user’s security access level.

Reagent Editor
Edit Add New

Reagent Types Reagents Type Antibody A-B Hazardous [ Yes

N Name Viscosity Level
Antibody C-C Bcl-6

Antibody D-N OpenTo | Customer

Antibody 0-Z

Negative This reagentis ready to use

Others

Special

Save Return

Figure 102

To add a new antibody (or antibody titration), select the Add New tab.
Select the Antibody group listed under Reagent Types. Antibodies are grouped alphabetically.

Input a unique antibody name in the Name field.

Each unique antibody product must have a unique name i.e.: different clone #, manufacturers,

dilutions etc.
Type Antibody C-C Hazardous [ Yes
Name CD20 1:400| Viscosity Level 1 2

OpenTo Customer
This reagentis ready to use

Figure 103
The option “Open To” is set by default to the user’s security access level.

The option “This reagent is ready to use” is set by default.
This field stores the mixing parameters of the reagent.

Check the box Hazardous to designate the reagent as hazardous, if needed.
All hazardous waste will be dispensed in the designated hazardous waste station.

The Viscosity Level is automatically set to 1 by default.
This field determines the liquid handling parameters of the reagent.

Click “Save” to add the new antibody to the system.
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To add a new reagent, select the Add New tab.
Select Negative, Others or Special under Reagent Types.
Note: The list of available reagent types may vary based on the system configuration.

Input a unique reagent name in the Name field.

A Contact Technical Support before using third-party reagents. Certain reagents may be chemically
incompatible and may cause damage to the instrument.

The option “Open To” is set by default to the user’s security access level.

Set the mixing parameters of the reagent:

A. Select the option “This reagent is ready to use” for reagents applied directly to the slide.
B. Select the option “This reagent is mixed on-board with the following parameters” for 2 reagents to be

mixed directly on the slide. Reagent mixtures that have a short activity time must be mixed on-board.
Note: Reagent A and B should have a low mixing ratio, i.e.: 1: 1.

Type Hazardous [ Yes
Name reagent AB Viscosity Level 1
OpenTo  Distributor

This reagentis mixed on-board with the following parameters.
Mixing Parameters

ReagentA reagentA Ratio 1

ReagentB reagentB Ratio 1

C. Select the option “This reagent is mixed on-rack with the following parameters” for 2-3 reagents to be
mixed on the reagent rack in a separate mixing vial before application to the slide.
Note: Reagent A, B (and C optional) may have a higher mixing ratio, i.e.: 1:20 or 1:30; however, the user

must set an appropriate minimum mixing volume to ensure the compositional accuracy of the mixture.
The maximum mixture volume must not exceed 16mL.

Type Specia Hazardous [0 Yes
Name reagent AB Viscosity Level 1 -
Open To | Distributor hd

This reagentis mixed on-rack with the following parameters. v

Mixing Parameters

ReagentA reagentA ~  Ratio 1
ReagentB reagentB ~ Ratio 30
ReagentC ~  Ratio 0

Minimum Volume (ul)  2000| -2

Check the box Hazardous to designate the reagent as hazardous, if needed.

Set the Viscosity Level. Refer to the Specialist User Manual for more details.

Click “Save” to add the new reagent to the system.
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To edit or remove an existing antibody or reagent, select the Edit tab.

Select the reagent from the list under the appropriate Reagent Type and edit the available fields, as needed.
Note: Users granted Supervisor access may only edit reagents Open to Customer.

Reagents designated Distributor or Closed are protected by the system and cannot be modified or removed.
Contact Technical Support for assistance.

Reagent Editor
Edit  Add New
Reagent Types Reagents Type Hazardous 0O Yes
Antibody A-B cD10 ~ | Name CD20 1:400 Viscosity Level
Antibody C-C CD117Rb
Antibody D-N CD138 OpenTo  Customer v
Antibody 0-Z CcD15
Negative cD20 This reagentis ready to use
Others CD20 1:400
Special cb21
cD23
CD34
CD56
cD7
CDX2
CEARD
CK19 v
Figure 104

Click “Delete” to delete the reagent from the system, as needed.
Note: The reagent cannot be deleted if it is used in an existing protocol on the system.

Click “Return” to exit.
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Preparing RFID Reagent Tags with the RFID Tag Editor
The system offers user-programmable vials for use with the user’s custom reagents and third-party antibodies.

Each programmable vial contains an RFID tag which will store all the information associated with that reagent. The
RFID tag may be reprogrammed for multiple uses, if needed.

Load the removable vial holder into bottom right corner of the reagent rack and then load the rack onto the

instrument.

Close the door and click “RFID Editor” to launch the RFID Tag Editor. The robotic arm will position the RFID
antenna over the vial holder. Place a user-programmable vial in the vial holder and remove the cap.

Read Tag

r:_’j RFID Tag Editer (Window Id: 2754280)

Show RFID Com

[] Use Robot and Reagent Rack

[Antibody C-C

|co20

[15mI

|60

[20220131

[202301

4

O X

‘ Write Tag |

[] GetReagent List From File

TaglD

Reagent Type

Reagent Name

Botile Type

Number Of Tests

Lot Number

Expiration Code (yyyymm)
Storage Temperature ('C)

Manufacturer Name

Catalog Number

E00402005431BF5B

Antibody C-C
CD20

15 ml

60

20220131

202301

4

—Add or Remove-—
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To read the information in the RFID tag, click “Read Tag”.

The programmed information will be displayed in the empty fields to the left.

Note: Brand-new RFID tags will not be read correctly, as they do not contain any data, only the tag manufacturer’s
randomly generated Tag ID.

To write information into the RFID tag, complete the entry fields to the right and click “Write Tag”.
Select the Reagent Type and Reagent Name from the drop down lists.

Note: Users with Supervisor access may only select user-added reagents and reagents Open To Customer.
Some reagents are restricted by the manufacturer and may not appear on the user-programmable reagent list.
Select the appropriate Bottle Type (15 or 7 mL).

The bottle type is required to ensure accurate liquid detection.

15 ml vials should be programmed for 60 tests, while 7 ml vials should be programmed for 30 tests.

All vials must be filled properly to the line indicated.

Enter the Storage Temperature.

Enter the Number of Tests Left.

Notel: The system may permit the user to reuse/reprogram user-programmed vials.

Please ensure vials are thoroughly cleaned and dried before re-use.

Note2: The system may block access for reprogramming reagent kit vials.

Enter the Lot Number (up to 12 characters) and Expiration Code (yyyymm).

(Optional) Select the Manufacturer Name.
Note: Select “---Add or Remove---“, from the dropdown menu to add a new reagent manufacturer name.

(Optional) Enter the Catalog Number.

The system will immediately read the tag after writing to verify and display the data in the left field.

Do not remove the vial until the tag ID on the left is highlighted in green to indicate that the tag has
been read successfully.

Note: The system will give a warning if the user chooses to re-use a programmed vial.
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Assigning Negative Controls
All protocols (except Special) are automatically generated with a corresponding negative control protocol. All steps
of the protocols are identical except the primary reagent which is substituted with the negative control reagent.
The negative control is set to Universal Negative by default.

Click “Negative Control Editor” to manage and assign negative controls for each protocol.
Note: Add new negative control reagents in the Reagent Editor, under reagent type Negative.
Refer to Reagent Editor, p. 78 for more information on adding new reagents.

Negative Controls

Protocols

Bcl-2 Extras
Bcl-6

CD10 Extras
CD138
CD15
CD20

cbD21

CD23

CD34

CD56

cD7

CDX2

CK19

CK20

CK7

CMV Probe
DNA- Probe

Clear Selected Protocols

Show Links To Negative

Figure 106

DNA+ Probe v

Negative Control

Mouse Negative
RNA Negative
Universal Negative

Clear Selected Negative

Show Links To Protocols

To view all protocols assigned to a negative control, select
the negative control from the list and click “Show Links to
Protocols”. All protocols linked to the negative control will be
highlighted under Protocols.

Click “Clear Selected Protocols” to clear the protocol
selection(s) displayed on the screen.

To view the negative control assigned to a protocol, select
the protocol from the list and click “Show Links to Negative”.
The negative control linked to the protocol will be highlighted
under Negative Control.

Click “Clear Selected Negative” to clear the negative control
selection displayed on the screen.

To assign a negative control to a protocol, select the protocol(s) listed under Protocols and select a negative
control reagent listed under Negative Control.
Tip: Hold down the Ctrl key to select multiple protocols.

To change the negative control assignment of the protocol, select the protocol(s) listed under Protocols and
select a different negative control reagent.
Note: The user cannot remove a negative control assignment, only change it. A negative control must always be
selected for every protocol.

Click “Save” to link the selected protocol(s) to the negative control.
Click “Reset” to reset all assignments back to the default negative control, Universal Negative.
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Creating Custom Groups

Click “Custom Group Editor” to edit/create custom lists of protocols for quick access to protocols in the Barcode
Label Editor. Refer to Add New Labels in the Barcode Label Editor, p. 19, for more information.

Select a custom group from the dropdown list Custom Group Name.
Protocols in the custom group will be listed under Selected Protocols.

To add a custom group, click “Add New Custom Group”, enter a New Custom Group Name, and click “Add”.

To add protocol(s) to a custom group, select protocol(s) from the list under Available Protocols, click “Add
Protocol”, and click “Save”.

To remove protocol(s) from a custom group, select the protocol(s) from the list under Selected Protocols, click
“Remove Protocol”, and click “Save”.

Edit Custom Groups
Custom Group Name No Custom Group Defined v Custom Group Name custom group 1 v
Available Protocols Selected Protocols Available Protocols Selected Protocols
Bcl-2 Extras a HPV 6 Probe A SOX10 Extras
"J N ! ] Kappa Probe S100
" Ki67 Rb MSH2
Lambda Probe Add MSHé6
Mammaglobin Protocol
New Custom Group Name |custom group 1 MLH-1 Extras
MSH2 R
s
Add Retum p40 Extras Special Protocol
p63
| CD56 I 1 I Pan CK Plus
cD7 v PAX-5 Extras v
| Add New Custom Group | Delete This Custom Group Add New Custom Group Delete This Custom Group
Save Return Save Return
Figure 107 Figure 108

To delete a custom group, select the group from the dropdown list Custom Group Name and click “Delete This
Custom Group”.

Click “Return” to exit the Custom Group Editor.
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Creating Custom Panels

Click “Panel Editor” to edit/create custom panels of protocols accessible in the Barcode Label Editor. Refer to Add

New Labels in the Barcode Label Editor, p. 19, for more information.

Select a panel from the dropdown list Panel Name.

Protocols in the panel will be listed under Selected Protocols.

To add a new panel, click “Add New Panel”, enter a New Panel Name, and click “Add”.

To add protocol(s) to a panel, select the protocol(s) from the list under Available Protocols, click “Add Protocol”,

and click “Save”.

Note: The user may choose to add a positive and/or negative control with each protocol if desired.

To remove protocol(s) from a panel, select the protocol(s) from the list under Selected Protocols, click “Remove

Protocol”, and click “Save”.

-l

=

Panel Name No Panel Defined

Available Protocols
Bcl-2 Extras A

Bel#

CD1 & Add New Panel - m] b4
cDi
CcD1
CD1
cDd
CD3
CcDi Add Return
CcDj

CDs
CcD7 ¥

Add New Panel

Save Return

Selected Protocols

New Panel Name [paneH

ETUve

Delete This Panel

Figure 109

u Edit Panels

Panel Name Vpanel 1

Available Protocols

HPV 11 Probe )
HPV 16 Probe

HPV 18 Probe

HPV 31 Probe

HPV 51 Probe

HPV 6 Probe

Kappa Probe

Lambda Probe
Mammaglobin

MLH-1 Extras

MSH2 N

Add New Panel

Save

Selected Protocols
Ki67 Rb

PR

|ERRb

Positive Ki67 Rb+

Negaive |Ki67Rb-

Add With

| Add

Delete This Panel

Return

Figure 110

To delete a panel, select the panel from the dropdown list Panel Name and click “Delete This Panel”.

Click “Return” to exit the Panel Editor.
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5.3. Security

Manage system security features under the “Security” tab.

System Utilities

Tools Editors Settings Network LIM

Change Password User Administration
Figure 111

Change Password
Click “Change Password” to change the current user login password.

Change Password

Re-enter New Password
A
Figure 112
User Administration

Click “User Administration” and login to view the list of users.

To add a new user, click “Add User” to open the “Add User” window.
Enter the Name, User ID and Password and set the Access Level.
Note: Only users with Distributor or Supervisor access level may create additional user accounts.

: Technician (customer) level will grant access limited to the
plserhisms =Gl CreeLaet essential features needed for routine operation of the

Supervisor Supervisor 2

Technician Tochnician instrument.

Add User . .
. Supervisor (customer) level will grant access to more

UserName A ] advanced features needed to configure and customize the

UserID | Technician A instrument.
Password ssssee

Re-enter Password | eeeees

Access Level

Distributor level (manufacturer) will grant full access to Tools,
Editors, Security and Settings.

Technician

o mewn

Figure 113

To remove a user, select the user in the grid and click “Delete User.”
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5.4. Settings

View system information and adjust system settings under the “Settings” tab.

Baking Slide Settings

Click “Baking Slides Settings” to set the Temperature (°C) and Baking Time (Minute).
Click “Save” and “Return”.

System Utilities

Tools Editors Security

Baking Slide Settings

2D Barcode Format

Check Heater Settings

Save All Customizations

GetDevice Version

[ Baking Slides Before Staining

Detect Waste Overflow
Run Without RFID Reader
Reagent Consumption Priority

@® Expiration Date
O Less TestNumbers

Network LIM

Software Version: 4.21330.0.8001
Allowed Reagent Assignment

Unlimited

Limited to =}

Interlock Enabled

Staining Run

System Initialization

Scan Slides

Scan Reagents

RFID Editor/Tubing Clean
Language:

English (United States) v

Enable Tubing Clean Tracking
Maximum Slides 135 2

Enable Module Tracking
Maximum Slides 50 :

Save

Figure 114

Configure Baking

Temperature ('C) 60

Baking Time (Minute) |59 =

Save

Figure 115
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2D Barcode Format
Click “2D Barcode Format” to open the “Barcode Label Options” and edit settings for the Barcode Label Editor.

Select the option for the Date Format.

Select the option Copy Patient Information to New Record to retain the patient information from the previous set
of labels for the next set of labels in the Barcode Label Editor.

Barcode Label Options (For LIS systems only)
L Select the option Show Slide UID to display the
Date Format | O | f° New Record unique slide ID received from the LIS system in
Show Slide UID . . .
d=Day MM/dd/yyyy O p,i:,wBam:de Using Siide UID the Slide Label Editor. This allows the user to
Ll MM/ddfyy [J Record from LIS use LIS label format identify slides ordered by the LIS system.
y=Year
yyMMdd Label Format
Edit Doctor Name List Select the option Print Barcode Using Slide UID
to generate the 2D barcode label using the
Label Entry unique slide ID received from the LIS system
Line: - [Mosptal Name —r instead of the system-generated ID.
Line2 Description test label
Select the option Record from LIS use LIS label
Printer. |ZDesigner GX430t . format to use LIS label formatting.
Top Margin: 65 S Left Margin 15 < Cancel
Width (dots) 252 |2 Dark Level 25 = 0K
Speed 3 2
Figure 116

Configure the layout of the label. Refer to Label Format, p. 86.
Manage the list of doctor names that appears in the Barcode Editor. Refer to Edit Doctor Name List, p. 87.

Enter default Label field names for Text Line 1 and Text Line 2 of the label.
Enter a default Entry for Text Line 1 and Text Line 2, as needed.

Select the Printer name from the dropdown list.

Ensure that a compatible label printer is connected and selected in the Printer dropdown list.

Adjust the Top and Left Margins, as needed.
Adjust the print Width, Dark Level and print Speed, as needed.

Click “OK” to close the window.

The default label print-out is displayed below for Label Style #1.

ACTH Pro-tocoIName
Patient ID PatientID
Case Numbert.... CaseNum
07/02/2013 DateTimeEntry 2D Barcode
Line 1 TextLinel
e ? TextLine 2 m/n
Figure 117
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Label Format

Click “Label Format” in the Barcode Label Options to open the Label Formatter and edit the printable data on the

label. Select the type of label to be formatted from the Label Format dropdown list:

Record Entered Locally configures the labels input

directly on the system.

Label Formatter

Label Format Record Entered Locally v

Label Style #1 Size 0.9x0.75 v
ProtocolName v
PatientiD v
CaseNum v
Date TimeEntry v
TextLinel v
TextLine2 v mn

Figure 118

Select the Label Style to change the layout of the label.

Select the data field identifier for each line of the label.

Record Received from LIS configures the labels

generated by the LIS system

Label Formatter

Label Format Record Recived from LIS

Label Style #1 Size 0.9x0.75

ProtocolName
PatientiDExternal

Containeridentifier

v

v

The user may change the order and type of data to be printed on each line of the label.
Note: Some data types are only available for use with an LIS system.

Click “Save” to save changes to the label format.

Note: Please verify that the printed data will not overlap with the 2D barcode label.
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DateTimeEntry v
ReceivingFacility v
AttendingDoctor1 v m/n
Save Return
Figure 119
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Edit Doctor Name List
Click “Edit Doctor Name List” in the Barcode Label options to display the list and add/remove entries.

To add a new doctor, enter a new name and click “Add”.

Edit Doctor Name List

Select or Enter a new name of doctor
|DoctorA v

Add Remove Return

Figure 120
To remove an existing doctor, select a name from the dropdown list and click “Remove”.

Check Heater Settings
The manufacturer configures the temperature, tolerance, and time for the heater check function.

Save All Customizations
Click “Save All Customizations” to back up all protocol customizations in the Protocol Editor.

‘@A The previously saved customizations will be overwritten. Therefore, the user should verify all
current protocol customizations in the Protocol Editor before proceeding.

Tools Editors Security Seftings Network LIM

Baking Slide Settings
Software Version: 4.21330.0.8001

Allowed Reagent Assignment
2D Barcode Format Unlimited

Limited to

Check Heater Settings

nterlock Enable

Staining Ru

S a

Save All Customizations

Get Device Version

[] Baking Slides Before Staining Language:

Confirmation X

0 Customizations for all protocols and reagents have been
saved!

Red

Figure 121

Tip: The user may restore an individual protocol or a selected group of protocols using the saved protocol
customizations by clicking “Refresh” from the appropriate tab in the Protocol Editor. Alternately, the user may
restore all protocol customizations by clicking “Refresh All Protocols” from the Template tab in the Protocol Editor

Device Version
Click “Get Device Version” to view the system device information.

ONCORE Pro X, Operating Manual, Rev. L 87



Baking Slides Option
Check the box Baking Slides Before Staining to set the system to automatically begin baking slides before the start
of every staining run. Set the time allotted for cool down after baking. Click “Save”.

/| Baking Slides Before Staining

After baking, slides will
cool down

5 | minutes.

Figure 122

Detect Waste Overflow Option (Distributor Access only)

Check the box “Detect Waste Overflow” to enable waste overflow detection of the wash stations. Click “Save”.
When the system detects overflow of a waste station, it will warn the user with a pop-up message and an alarm.
If the non-hazardous waste station has overflowed, the system will divert waste to the hazardous waste station.

Run Without RFID Reader Option (Distributor Access only)
Check the box “Run Without RFID Reader” to disable the RFID Reader. Click “Save”.
This option should only be used in the event of an RFID reader failure.

Reagent Consumption Priority
Set the usage priority when multiple vials of the same reagent are scanned during Reagent Check. Click “Save”.

The option “Expiration Date” will prioritize the consumption of reagents with an earlier expiration date.
The option “Less Test Numbers” will prioritize the consumption of reagents containing fewer tests.

Detect Waste Overflow
Run Without RFID Reader
Reagent Consumption Priority

® Expiration Date
O Less TestNumbers

Figure 123

Software Version
Contact Technical Support for release notes and information about the latest software updates.

Allowed Reagent Assignment (Distributor Access only)
Set the allowed number of manually assigned reagent tests. The number must be reset if the user exceeds the
limit. Please contact Technical Support for assistance.

Interlock Options (Distributor Access only)
Set the safety interlock configuration. The interlock may be enabled/disabled for the listed processes. Please
contact Technical Support for assistance.

Language

Select the system operating language from the dropdown list. Click “Save”. The system will prompt the user to
restart the application to apply the changes.
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Tubing Clean Tracking Option (Distributor Access only)

Check the box Enable Tubing Clean Tracking to track the number of slides run since the last tubing clean.
Enter the Maximum Slides Run. The count is incremented after each staining run.

When the system detects that the counter has exceeded the set threshold, the system will block the user from
starting a new staining process until the tubing cleaning has been performed.

ONCORE Pro X System Software

2112022
Scan Assign Scan System Clean

7- 1 3 PM Sides  Protocols | Reagents |  Utiies Screen Bt

MNIT Zgm Load
CNCOR= propare | | Lo8d ||

Labels Slides 5
Ve 213302

Figure 124

Module Tracking Option (Distributor Access only)

Check the box Enable Module Tracking to track the number of slides run on each module since the last reset.
Enter the Maximum Slides Run. The counter for each chamber is displayed on the upper right corner of its grid on
the slide map. It is incremented after each staining run.

When the counter has exceeded the threshold, it will be highlighted in red to alert the user to replace the
chamber(s) and reset the counter.

ONCOR= e et 2j1/2022
AN —Em Prepare Scan Assign Scan System Clean
Labels || moad | Ao Star 5:-10 PM Slides | | Prolocols | Reagenis || Usiites | Screen =
Va213302 -
EN [ 61 ] [ 61 |
: : 3 . s f 7 . s 1 " 2
Ex Ex EX Ex Ex [ 51 ] Ex Ex
) s u 1 3
E [ 57 ] Ex
s ' ' p 3 ) 1 a 3 35
Logs 200 out of 200 sides and 20 tolal runs since last tubing clean
'™ Done ~
S
M: Done.
M- Sy o oy, -
Figure 125
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5.5. Network

Connect several Slide Stainer systems over the local network under the “Network” tab.

The systems connected over the network may print from a dedicated printer on a main PC/server and share 2D
barcode label records. Slides may be placed and run interchangeably on all systems connected over the network.
Contact Technical Support to setup the network and connect existing system(s) to the network.

Tools Editors Security Setiings Network LM

Network Machines

PC17002

Information X

o PC17002 is on the network and is connected.

Return

Figure 126
All system(s) connected to the current system will be listed under Network Machines.

To test the connection, click “Test Connection” to check if the current system is properly connected to the
selected network machine/main server PC.

To avoid unexpected errors, please ensure that all network machines are connected to the
network during instrument operation.

If the connection is not detected, check that all systems are connected to the local network.
Check settings in Windows Control Panel>Network and Internet.

ONCORE Pro X, Operating Manual, Rev. L 90



To add a network machine, click “Add”. The system will display a list of Available Network Machines.

Select the name of the network machine from the list and click “Add the selected network machine”.
Note: The name of the network machine is the same as the computer name.

Find Metwork Machines

Available Network Machines

PC12009
PC17030
PC17031

Add the selected network machine

The machine that | want iz not listed

Return

Figure 127

Alternatively, if the machine is not detected, click “The machine that | want is not listed” to manually input the
network machine name.

Add a Metwork Machine

Enter Network Machine Name: PC21082 |

For example: PG12007 Return

Figure 128

Click “Add” and input the User ID and Password when prompted.
Note: Use the computer login ID and password.

User ID and Password
UserID: |BioCare |
Password: |"".| |
Enter
Figure 129

To remove a network machine, click “Remove”.
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To print from a network printer, go to the “Settings” tab and click “2D Barcode Format”.

Select the shared network printer from the Printer dropdown list.
The printer name will appear preceded by the system name on the network.

2y 7 Designer GX430 t]
FDesigner GX430t

Top Ma o Complete

Width (¢ Microgoft XPS Document Writer
Fa

SWPC11008' 7 Designer GX430

Figure 130

Change the label format options as needed.

If the network printer does not appear in the dropdown list of printers, add the network printer to
the system in Windows Devices and Printers and share the printer.

Do not share more than one printer on the network. Uncheck any other shared printers, as they
many cause unexpected errors.

Note: If a printed label is not recognized, make sure that all systems are connected to the network, as this will

ensure that the record of printed labels is up to date across all systems.
Note2: the label records are shared when the label is printed or moved to the printed slides.

5.6. LIS/LIMS

The system supports HL7 Server connection and MSSQL Database connection.
Contact Technical Support for more information regarding the setup requirements.

Systern Utilities
Tools Editors Security Settings MNetwork LIM

HL7 Connection Enabled [] Database Connection Enabled

HL7 Server IP Address |192‘ISS.‘I.‘\26

HL7 Server Port Number

Send Result When Finished

Connector Application Name HL7Connector.exe|

Save Settings

Figure 131
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Section 6. Reports

The system provides a basic report utility to track slides, run sessions, and reagent consumption
From the Main screen, click “System Utilities” and open the Tools tab to access the Report Generator utility.

6.1. Generate a Report

Click “Generate Reports” to open the Report Generator.

Slide Barcode
To track a processed slide by 2D barcode, select the Slide Barcode option and click “Start”.

Report Generator

Generate Report By Using

@® Slide Barcode
O Patient Information

O Staining Runs

Figure 132

When prompted, place the slide in the selected position 1-36 on the instrument. The 2D barcode reader will scan
the unique 2D barcode on the label and trace the slide in the data logs.

Report By Slide Barcode
Please place the slide to report in slot =
Slide Report Show All Runs For This Slide Return
Figure 133

A. Click “Slide Report” to generate the report for the scanned slide. Refer to Report Types, p.96, for more
information.

B. Click “Show All Runs For This Slide” to generate a Run List of all runs that include the scanned slide.
Note: The Run List may associate 2 or more runs with a given slide if its run process was interrupted by the
continuous loading feature. Each time the instrument is stopped to load more slides, the system must
generate a new run schedule and initiate a new staining process.

C. Click “Return” to return to the previous screen to scan a new slide or select a different option.
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From the Run List, the user may choose to:

i.  Select a run by clicking the empty grid in the leftmost column (the row will be highlighted in blue).
Click “Show All Slides In Selected Run” to generate a Slide List of all slides in the selected run.
ii. Click “Reagent Usage Report” to generate a summary of the total reagent usage for all runs in the list.

Run List

Start Date 2/ 1/2022 [Ehg End Date 2/ 1/2022 B~

Instrument
Serial

Start Time End Time Status Total Slides

Operator

Distributor

Total Unique Slides

I

Show All Slides In Selected Run | | Reagent Usage Report |

Figure 134

From the Slide List, the user may choose to:

i. Select another slide in the same run by clicking the empty grid in the leftmost column (the row will be
highlighted in blue). Click “Slide Report” to generate the report for the selected slide. Refer to Report

Types, p.96, for more information.

ii.  Click “Slide Summary Report” to generate the report for summary of the slides in the run. Refer to

Report Types, p.96, for more information.
iii.

Report Types, p.96, for more information.

Click “Reagent Usage in Run Report” to generate the report for reagent usage in the run. Refer to

Slide List

Slide

Protocol Name Position

Ms HRP Template

Status

[Finished]

Ms HRP Template .. | [Finished]
Patient A 123456 02/01/2022 13:09 02/01/2022 15:32 CD20- 36 Ms HRP Template [Finished] 3
<
Slide Report ‘ | Slide Summary Report ‘ | Reagent Usage in Run Report
Figure 135

Note: To obtain a report from a manually assigned slide, select the Staining Runs option. Refer to p. 96 for details.
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Patient Information

To manually track a processed slide by patient information, select the Patient Information option and click “Start”.

Report Generator

Generate Report By Using

O Slide Barcode
@ Patient Information
O Staining Runs

Start | l Return

Figure 136

The system will display all processed slides in the Patient Information list. Search the list by entering the Patient ID
in the search box, Search Patient ID. Sort the list by any column by clicking the column header.

Patient Information

Search PatientID Patient A

Patient ID Case Number Specimen Block ID Addional
Type

Additional Additional Additional
Information 1 Information 2 Information 3 Information 4

| Slide Report ‘ ‘ Show All Runs For This Slide |

Figure 137

From the Patient Information list, the user may choose to:

i. Select aslide by clicking the empty grid in the leftmost column (the row will be highlighted in blue)

Click “Slide Report” to generate the report for the selected slide.

Select a slide by clicking the empty grid in the leftmost column (the row will be highlighted in blue).
Click “Show All Runs For This Slide” to generate a Run List of all runs that include the selected slide
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Staining Runs
To manually track a slide by the run session, select the Staining Runs option and click “Start”.
Note: This is the only method for tracking a manually assigned slide.

Report Generator

Generate Report By Using

O Slide Barcode
O Patient Information

@® Staining Runs

Start Return

Figure 138

The system will generate a Run List of all run sessions. The number of Total Unique Slides that have been
processed on the system is displayed at the bottom of the list.

Select a Start Date and End Date to display all runs in a given time period.

Run List
Start Date 3262021 [T | End Date 5/28/2021 B~ |
T ¢ March 2021 »
Instrument L

Start Time Sun Mon Tue Wed Thu Fri Sat jus ol Shdes Serial Operat

R 03/26/2021 1941 [ hed 12 |pc21013 Distribut
03/26/202120:10| 14 15 16 17 18 rted 3 PC21013 Distribuf
ooTpeiias & 2 L 5 5. hed 12 PC21013 Distribut
03/27/20211505| 4 5 6 7 8 9 10 phed 1 PC21013 Distribut
03/27/2021 16:19 [ Today: 1/31/2022 hed 1 PC21013 Distribut
03/27/2021 16:51 03/27/202117:15 Finished 1 PC21013 Distribut
03/27/2021 18:13 03/27/2021 18:22 Finished 1 PC21013 Distribut
03/27/2021 18:30 03/27/2021 18:54 Finished 1 PC21013 Distribut
03/27/2021 19:06 03/27/2021 19:22 Finished 1 PC21013 Distribut
03/27/2021 19:41 03/27/2021 19:43 Aborted 1 PC21013 Distribut
03/27/2021 1951 03/27/2021 20:07 Finished 1 PC21013 Distribul
03/29/2021 08:39 03/29/202109:32 Finished 1 PC21013 Distribut
03/29/202111:56 03/29/202112:15 Finished 2 |PC21013 Distribut
03/29/2021 13:12 03/29/202113:23 Finished 2 |PC21013 Distribut
NAMIN21 1347 N3U2Q/72021 1R Finichad 2 Pr21n11 Nictribud o

< >

Total Unique Slides |694
Reagent Usage Report Return
Figure 139

From the Run List, the user may choose to:
i. Select a run by clicking the empty grid in the leftmost column (the row will be highlighted in blue). Click
“Show All Slides In Selected Run” to generate a Slide List of all slides in the run.
ii. Click “Reagent Usage Report” to generate a summary of the total reagent usage for all runs listed in the
Run List for the selected time period.
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6.2. Report Types

Slide Report
The Slide Report provides the run summary for an individual slide. The report can be generated by scanning a slide
using the Slide Barcode Option or by selecting a slide from a Slide List or Patient Information list.

a5 Slide Report - O »
1 of 1 (GARE="IE rn " Rt - Find | Mext
Slide Report

21/2022 5:22:50 PM

Instrument ‘Operator Run 1D Slide IDv

PC21085 Dis tributor usSm3 EnCEE200k_TMbY4rg GmCngfqokOVa4pBHiTRAg

Patient 1D Case Number Block ID Specimen Additional Additional

Infermation 1 Information 2
Patient A 1223468 a4 Tiesue  Hospital F test |abel
Protocol Name Detection Positi Ctr* LIS  Start End
on

Ch20 Ms HRP Template 2 24 1N 22022 2172022
V2/1230ul 20151022 end 10238 PM 23242 PM
220ulhas

Status

[Finis hed]

Reagent Name Time Tempera Volume Lot Number Catalog Expiry Date
{hhomm:ss) ture [C%  [ul} Number

051 0:05:00 85 240 220121 1 202207

D52-50 0:04:20 58 200 220121 2 202207

ARZ, lowpH 0:22:00 101 370 220124 3 202207

Sys tem Fluid 0:0420 33 220 MrA A 202202

Co20 0:20:00 25 120 220121 4 202207

Sys temn Fluid 0:00:10 25 220 NrA MA 202202

Mouse HRP 0:20:00 25 130 220131 5 202307

Sys tem Fluid 0:04:20 k] 240 N/A A 202202

Sys temn Fluid 0:04:20 =] 280 NIA MA 202202

DAB 0:08:40 = 200 MrA On Rack Micing 202202

Sys tem Fluid 0:00:10 25 240 NPA A 202202

Ctre:0, Unknown; 1, Nemal s lide; 2, Positive control slide; 3, Negative control slide.

Figure 140
The first line displays the date and time that the report was generated.
The first table displays the Instrument Serial Number, Operator name, unique Run ID, and unique Slide ID.

Note: The slide may be associated with 2 or more unique Run IDs if its run process was interrupted by the
continuous loading feature.

Instrument Crperator Run 1D Slide 1D
PCZ085 Dis tributor us5mIEn0GEI00E_TMEY4rg | GmingXfgokOVa4pBXiTRAg
Figure 141

The second table displays the Patient ID, Case Number, Block ID, Specimen Type, Additional Information 1, and
Additional Information 2.

Patient ID Case Number Block ID Specimen Additional Additicnal
Informatiocn 1 Infermation 2
FPatient A 123458 24 TiesueX  Hospital F test label
Figure 142
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The third table displays the Protocol Name, Detection Type, Slide Position, Control Type (normal, positive or
negative), LIS(yes/no), Start Time, and End Time.

Note: The table will display 2 or more sets of Start/End times if the run process was interrupted by the continuous
loading feature.

Protocol Name Detection Positi Ctr* LIS Start End
on
CD20 e HRP Temglate 2 M 1N 20/2022 2172022
W2/130ul 20181022 end 1:08:32 PM 23242 P
220ulsd
Figure 143

The fourth table displays the Run Status, logging any warnings/errors that occurred during the run and the final
status [Finished].
Note: The [Stopped] status indicates that the run process was interrupted by the continuous loading feature.

Status
[Finis hed]
Figure 144

The fifth table displays a summary of the protocol steps performed (Reagent Name, Incubation Time and
Temperature, Volume) and reagents used (Lot Number, Catalog Number, Expiration Date) on the slide.
Note: System Fluid and manually assigned reagents will display an Expiry Date using the current month by default.

Reagent Name Time Tempera Volume Lot Number Catalog Expiry Date
(hh:mm:ss} ture (C7%  [ul} Number
DsA 0:05:00 85 240 220131 1 202307
D52-50 0:04:30 5B 200 220131 2 202307
ARZ, low pH 0:22:00 101 370 220131 3 202307
Sys tem Fluid 0:0420 33 220 NiA WA 202202
CD20 0:30:00 25 130 220131 4 202307
Sys tem Fluid 0:00:10 25 220 NiA WA 202202
Mowse HRP 0:20:00 25 130 220131 5 202307
Sys tem Fluid 0:0420 35 240 NiA WA 202202
Sys tem Fluid 0:04:20 35 240 WA WA, 203302
DAB 0:08:40 v 200 NiA On Rack Miing 2022-02
Sys tem Fluid 0:00:10 25 240 WA WA, 203302
Figure 145
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Reagent Usage in Run Report

The Reagent Usage in Run Report provides a detailed summary of the reagents used in an individual run. The
reagents used in the run can be traced back to individual reagent vials by using the Tag ID, or by batch using the
Lot Number.

The report can be generated from any Slide List.

5! Reagent Report - m] X
1 of 1 @ & G A W | 100% - Find | Mext

Reagent Usage In Run Report
2/1/2022 5:23:57 PM

Instrument Operator Name Start Time  End Time Status Total Slides Run UID

PC21085 Distributor 21142022 2/1/2022 Finished 3 usEm2EnCGE200k_UMbY4rg
1:09:20 PM - 3:32:42 PM

Reagent Name Test Test Position Catalog Lot Number  Expiry Vendor
Contained Used Number
DS1 E004020054BEROTS 47 3 11 220131 202307 BIOCARE
MEDICAL
DS2-50 E004020054545569 47 3 22 220131 2023-07 BIOCARE
MEDICAL
AR2, low pH E004020054BEAFED kxl 3 33 220131 202307 BIOCARE
MEDICAL
cD20 E004020055269E47 58 2 64 220131 202307 BIOCARE
MEDICAL
Universal Negative ~E00402005491CC%8 99 1 10 8 220131 2023-07 BIOCARE
MEDICAL
Mouse HRP E00402005491BDAY 97 3 55 220131 202307 BIOCARE
MEDICAL
DAB Buffer E004020054915B07 55 5 76 220131 2023-07 BIOCARE
MEDICAL
DAB Chromogen E00402005496D10D 55 5 47 220131 2023-07 BIOCARE
MEDICAL
DAB FFFFFFFFFFFFFFFE 0 3 40 On Rack MNiA 2022-02 NiA
Mixing
10of1
Figure 146

The first line displays the date and time the report was generated.

The first table displays the Instrument Serial Number, the Operator Name, the Start Time and End Time, the Run
Status, the Total Slides, and the unique Run ID.

The second table displays a summary of all reagents used in the run (Reagent Name, Tag ID, Test Contained, Test
Used, Position, Catalog Number, Lot Number, Expiration Date, Vendor Name).
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Reagent Usage Report

The Reagent Usage Report provides an overall summary of total reagents usage for a user-specified time period.
This data may be useful for ordering and tracking reagent consumption.

The report can be generated from any Run List.

a-! Reagent Usage Report - O bt
1 of 1 & E o | | Find .
Rsa gent Liea ga Raport
MIDE SEZEIZFM
Frm To
NASDN GO 2Imz11sasseu

Figure 147
The first line displays the date and time the report was generated.

The first table displays the user-specified time period used to generate the list.
Note: The report can also be generated using a Run List for an individual slide.

The second table displays a list of all reagents and the number of tests used for each. The last line of the table
displays the total number of tests used in the user-specified time period.
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Slide Summary Report
The Slide Summary Report provides an overall summary of all slides in a-specified run.
The report can be generated from any Run List.

g Slide Summary Report -

H 41 of1h M|« @ & G E- | 100% - Find | Next

Slide Summary Report

2/1/2022 5:23:36 PM

V3/130ul 20181022 end
220ulA4

Figure 148
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Patient ID Case Number Protocol Name | # MNote Status
Patient A 123456 D20 34 Ms HRP Template 2 Finished
W3/130ul 20181022 end
220ulag
Patient A 123456 CD20 35 Ms HRP Template 2 Finished
V3/130ul 20181022 end
220ulad
Patient A 123456 CD20- 36 Ms HRP Template 2 Finished
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6.3. Print and Save a Report

The system can generate several types of reports. Navigate each report by using the page number, arrows and
search box located in the toolbar.

‘ 1 o272 p M @ | & B W | 100% - Find i

To print a report, click the Print icon @ in the toolbar and select a valid network printer.
@ A Do not select the barcode printer.

To save a report, click the Export icon ", in the toolbar and select the application: Excel, PDF, or Word.

6.4. Backup Report Data

From the Main screen, click “System Utilities” and open the Tools tab.
Click “Backup Report Data” to access the backup feature.

Select or enter a date in Backup Report Data Before. Click “Backup” to backup all data before the selected date.

Select the option to retain or remove the data after Backup Report Data
backup:
A. “Keep selected files after backup”

B. “Remove selected files after backup” Backup ReporiDataBeiore M31/02 8-

@® Keep selected files after backup

O Remove selected files after backup

Backup Return

Figure 149

Select a folder location where the backup will be saved ie: local disk or external flash drive.
Alternatively, the user may create a new folder location by clicking “Make New Folder”. Click “OK” to proceed.

Browse For Folder X

Select location to backup report data

Users A
Windows
s DATA (D)
«a RECOVERY (E:)
sy Libraries
g% Network
[£5] Control Panel
&' Recycle Bin

Backup Report Data v

MakeNewFolder | | oK Cancel

Figure 150

All report data files created before the selected date will be copied to a new folder named “ReportDataBackup”
appended with the current date.
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Section 7. System Maintenance

The user should adhere to a routine preventative maintenance schedule to maximize the reliability and lifespan of
the instrument. Contact Customer Service for a supply of spares and consumable items.

7.1. Daily Maintenance Recommendation

Modules

The modules should be cleaned routinely (recommended after every run) to prevent the buildup of salt and
reagent residues.

Unload all slides from the system.

Remove the chambers from the modules and set aside in DI water for cleaning later.

Use a soft paper towel to wipe the surface of the heater and around the inner edge of the slip holder.
Insert the paper towel into the hinge to absorb any excess liquid remaining after the run.

Use a lint-free alcohol wipe to wipe away any remaining reagent residues.

ukhwh e

Chamber
The chambers should be cleaned routinely (WEEKLY or after every five runs) to remove staining residues that could
negatively affect staining quality.

Run the chamber cleaning protocol on all 36 module positions:
1. Load the provided ONCORE Pro Chamber Cleaning Kit onto the system.
a. Fill two of the provided empty vials labeled “DI Water” with distilled water.
b. Loada “Clean 1”, “Clean 2”, “Clean 3” and two full “DI Water” vials onto the reagent rack. A second
“Clean 3” may be needed for sufficient volume.
¢. Remove all reagent vial caps.
d. Click System Utilities>Tools>”"Move Arm to Middle”. Always move the robotic arm aside before
adding or removing the reagent rack.
2. Load clean blank slides onto all 36 module positions.
a. Click “Load Unload Slides” to raise the lids.
b. Click “Slide Lids Down” to lower the lids after loading the slides.
3. Highlight all 36 module positions and click “Assign Protocols”. Highlight the “Clean Chamber” protocol and
click “Select”.
4. Click “Scan Reagents”.
5. Click “Start Staining Run”. The run will take approx. 2.5 hours.
6. Once complete, remove all vials and discard the 2 “DI Water” vials and any other empty vials. Remove and
discard all 36 slides.
7. Wipe chambers and clean with lint-free alcohol wipes. Wipe the edges of the chamber housing.
8. Click System Utilities>Tools>"Move Arm to Middle”. Gently wipe probes tips and wash stations with alcohol
wipes, removing any salt build up.

Tubing and Pumps

(If applicable) Inspect tubing and pump syringes for leakage or a severe buildup of salt.
Contact Customer Service to schedule a maintenance visit, if needed.
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7.2. Weekly Maintenance Recommendation

Modules and Deck Plate

The modules and deckplate should be cleaned and inspected routinely to maintain proper function.

1. Use a damp paper towel to wipe away any salt deposits that have accumulated on the module surfaces.

2. The user may pipette distilled water and/or alcohol into the hinge slot to dissolve any crystallized salt
deposits.

3. The user may use a small tool such as a paper clip to remove any debris or glass fragments that are obstructing
the hinge slot and preventing the slides from inserting properly.

4. Use a soft paper towel to absorb any excess liquid that has accumulated in the grooves of the deckplate.

5. (Optional) Perform a module and heater function check. This should be performed after receiving a
temperature/module malfunction warning. Refer to Check for Module Malfunction p. 53 for more
information.

Wash Station and Z1/Z2 Probes

The waste stations and probes should be cleaned routinely to prevent salt obstructions.

1. Use a lint-free alcohol wipe to clean any reagent residues and salt deposits that have accumulated on the
surface of the wash stations and probes.

2. Click System Utilities>Tools>"Move Arm to Middle” to gain access to the wash station and probes.

Take care not to bend the probes. Verify the alighment of the Z1 and Z2 probes if needed.
3. Inspect the percolation holes on the wash station and clean with a cotton swab and alcohol if needed.

Tubing and Pumps

The tubing and pumps should be primed with distilled water if the instrument is to be left idle for a prolonged
time, such as on long weekends or holidays.

Push the quick disconnect release to detach the buffer container and remove it from the instrument.
Empty and rinse out the contents.

Fill the buffer container approximately 1/3 or more full with DI Water and re-connect to the tubing.

Click System Utilities>Tools>”Prime Z1 and Z2"” to prime the pumps and tubing several times.

Detach the buffer container and empty the remaining contents.

ukhwn e
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7.3. Monthly Maintenance Recommendation

Chambers
The chambers should be inspected routinely and replaced as needed (estimated after every 50 runs).

Tubing

The tubing should be inspected and cleaned routinely (recommended after every 500 slides) to prevent buildup of

reagent residues. An obstruction in the tubing line may cause inconsistent/negative staining results and premature

wear on the pumps.

1. Ensure that the buffer container is filled and connected to the tubing.

2. Load the reagent rack with cleaning solutions for Z1 and Z2 in the designated positions.

3. Click System Utilities>Tools>"Tubing Clean” to initiate tubing clean. Refer to Clean Z1/Z2 Tubing, p. 51 for
more details.

Aclean tubing as frequently as needed. Visually inspect the tubing for buildup of wax deposits or
DAB/Hematoxylin precipitate.

Robotic Arm

The robotic arm should be inspected routinely to maintain proper function.

1. Click System Utilities>”SP1-Z1 Calibration” and “SP1-Z2 Calibration” to verify the alignment of the Z1 and 72
probes.

2. Verify that the robotic arm is operating smoothly.

3. System calibration may be performed by a trained service technician if the probe becomes severely bent.
Contact Customer Service for assistance.

Computer
The C:/PathCom folder should be backed up routinely onto a flash drive/external device.
Please contact Technical Support for additional assistance.

7.4. Annual/Semi-Annual Maintenance

Annual/semi-annual maintenance on the whole system must be performed by a trained service technician.
Contact Customer Service to schedule a maintenance visit.

A scheduled maintenance may consist of:

Inspection of 36 modules. Replacement of modules or parts as needed.

Module calibration and testing as needed. Replacement of module O-rings as needed.
Inspection of the robotic arm. Lubrication of the XYZ rails.

System calibration of the XYZ robotic arm as needed.

Inspection of all probes/tubing/hoses and replacement of parts as needed.

Inspection of pumps. Replacement or cleaning of syringes as needed.

Software and Firmware upgrade if applicable.

Running diagnostics on the system.

Backup and removal of logs and data files.

RN WNRE
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Section 8. General Precautions

Make sure the slides are placed securely on the module — the slide should be pushed in against the spring and the
spring should push the slide back under the slide clips.

Place the reagent rack firmly in its seated position before starting a run on the instrument.
Remove caps from reagent vials before starting a run on the instrument.

Keep the door closed during operation. The robotic arm will move unexpectedly during operation - stay clear. Do
not impair the movement of the robotic arm in any way.

Contact Customer Service prior to using reagents and solutions supplied by other vendors on your Slide Stainer.
Some solvents, acids, and other solutions may cause damage to the internal components of the Slide Stainer and
affect your instrument's performance and warranty.

Wear disposable gloves and protective lab wear when handling reagents. Reagents are harmful and irritating to
the eyes, respiratory system and skin. It may cause lung and stomach damage if ingested. SDS are available from

your local sales representative or online at biocare.net.

Hazardous reagent wastes must be disposed of according to local, state and federal regulations. Wear
appropriate Personal Protective Equipment to prevent exposure.

Do not multitask or run CD/DVD players on the computer while the instrument is in operation. Multitasking is
defined as running more than one software application at a time. This may lock up the instrument.

Disable Windows Automatic Update and other background programs while the instrument is in operation.
Disable the Local/Wireless Internet Connection. The system should not be connected to the Internet.

Do not modify Windows Power options or install a screen saver. This may cause the computer to power off
unexpectedly while the instrument is in operation or may lock up the instrument.

Do not install third party software or hardware products. Installing third party products may lock up the
instrument and may void the warranty.

Do not make any hardware or software changes before consulting Technical Support.

Do not use a USB cable longer than 3 meters (10 feet).

Restart the computer if:
1) The USB is disconnected/reconnected. Always connect the USB to the designated USB port.
2) The power supply to the instrument is powered on/off or disconnected.
3) The computer is put into Sleep Mode or Hibernation Mode.

4) The user encounters an unexpected error.

Do not attempt to service the instrument unless instructed to do so by Technical Support. Doing so will void the
warranty.

Do not relocate the instrument to another site within your facility before contacting Customer Service for vital
information that may affect your warranty.
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